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Release Date
16 August 2018

Qualified Operating Systems
• macOS Sierra (10.12) or macOS High Sierra (10.13)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)
Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration
If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.

NVIDIA
An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.
NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.
With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA
GPU. Driver version r361 or above is required.
Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you
don't have it already. The minimum requirement is driver version r361 which can be downloaded
from www.nvidia.com/drivers.
NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

AMD
• On Windows and Linux, an AMD GPU and driver from the following list:
Windows GPU

Driver

Linux GPU

Driver

AMD FirePro W8100

17.Q2.1

AMD FirePro W8100

17.Q2.1

AMD FirePro W9100

17.Q2.1

AMD FirePro W9100

17.Q2.1

AMD Radeon R9 Fury X

17.4.3 - 17.6.2 AMD Radeon R9 Fury X

17.10

AMD Radeon RX 480

17.Q2.1

17.Q2.1

AMD Radeon RX 480

AMD Radeon Pro WX 7100 17.4.3 - 17.6.2 AMD Radeon Pro WX 7100 17.10

NOTE: Other AMD GPUs may work, but have not been fully tested.
• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016
MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

Mac GPUs
Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and
late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multiGPU support option. When enabled in the preferences, GPU processing is shared between the
available GPUs for extra processing speed.
NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend
updating Mavericks to 10.9.5, or above for full functionality. However:
• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.
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• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 352907 - Write: You can now specify which channel is written first in multi-channel .exr files
using the first part dropdown in the Write node's Properties panel. All subsequent channels are
written in alphanumeric order.

Bug Fixes
• BUG ID 133297 - Project Settings: The right-click Edit > Edit Expression option on the Color tab was
not grayed-out when no LUT curve was selected.
• BUG ID 156605 - Write: Codec options were not consistent between interactive and command-line
renders.
• BUG ID 281553 - Linux only: The Project Settings > Color Management > Default Color
Transforms were not populated with LUTs if an OCIO config was specified using and environment
variable.
• BUG ID 331524 - ARRIRAW: Changing the color space control and then clicking the Revert all
changes option in the Properties panel displayed an Invalid LUT error in the Viewer.
• BUG ID 337765 - R3D: Clicking Load Settings from RMD did not populate the Color Space and
Gamma Curve controls correctly.
• BUG ID 351195 - R3D: Loading certain CDL files displayed unhandled exception errors.
• BUG ID 351446 - OCIO: Default values were saved incorrectly to the preferences.nk file.
• BUG ID 353294 - OCIO: Nuke Studio and Hiero used the uistate.ini for colorspace defaults even
when the OCIO environment variable was set.
• BUG ID 355262 - ARRIRAW: The thumbnails for Read nodes referencing .mxf files displayed
incorrectly.
• BUG ID 357315 - The right-click context menu in the Nuke 11.2 Properties panel was inconsistent
with legacy versions of Nuke.
• BUG ID 357725/359571 - OCIO: Changing the OpenColorIO settings in the Preferences caused
errors in the Project Settings after saving and reloading the project.
• BUG ID 357825 - OCIO: Setting the OCIO environment variable did not affect the Project Settings.
• BUG ID 358470 - Timeline: Setting a color for a shot disabled the timeline keyboard shortcuts.
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• BUG ID 360365 - The Project Settings panel was resized incorrectly.

New Known Issues Specific to this Release
This section covers new known issues and gives workarounds for them, where appropriate.

New Known Issues Specific to Nuke
• BUG ID 355719 - ARRIRAW: Deprecated resolution modes are not labeled in Nuke.
• BUG ID 355712 - ARRIRAW: The 2668 resolution output mode, necessary for ProRes output, is
currently not available.
• BUG ID 347416 - Rendering a standard Write node that has deep data in its stream causes Nuke to
crash.
• BUG ID 340749 - Mac OS X/macOS only: Reading .r3d files and changing the color version to v1
produces a corrupt image.
This is a known issue in the RED SDK, and will be addressed in a future release.

Other Known Issues
This section covers legacy known issues and gives workarounds for them, where appropriate.

Known Issues Specific to Nuke
AudioRead
• BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled
between file and custom.
• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.
• BUG ID 18465 - The time range control doesn’t limit the range when an endtime is specified.
• BUG ID 18451 - Flipbooking doesn't honor the time range knob.
• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.
• BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn't redraw the curves
correctly.

RELEASE NOTES
4

Release Notes for Nuke and Hiero 11.2v3 | Other Known Issues

BlinkScript/CUDA
• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA
error when the OS wakes up from sleep mode.
As a workaround, close and reopen Nuke to reactivate the CUDA drivers.

CameraTracker
• BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez
modes.
• BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image
in reference thumbnails, rather than just the RGB values.

Deep
• BUG ID 43383 - Executing a script in command-line mode that reads in a deep image and then
writes it to disk, causes Nuke to crash.
As a workaround, run the script from the Script Editor inside Nuke.
• BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1.
As a workaround, preview the .exr in the file browser before reading it into Nuke.

Dope Sheet
• BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you
execute Analyze Sequence with the Dope Sheet open.
• BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.
• BUG ID 39426 - Undoing individually animated text characters removes their keys completely from
the Dope Sheet.
• BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames
when frame snap is enabled.
• BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.
• BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to
have a non-empty frame expression.
• BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated.
• BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented
once in the Dope Sheet.
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EditGeo
• BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on
geometry with animation baked into its vertices.
To update the transform handle, toggle the axis alignment control between object and average
normal.
• BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to
ignore the EditGeo node.
• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe
marker.
• BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and
corner vertices.

Flipbook
• BUG ID 271435 - Flipbook: Using the flipbook with nuBridge installed causes Nuke to crash.
• BUG ID 201156 - Nuke's flipbook defaults to the Write node's colorspace, which can result in
different output when compared to the Viewer.
As a workaround, either flipbook the node upstream of the Write node, or enable Burn in the LUT
in the Flipbook dialog.
• BUG ID 47005 - In the Flipbook Viewer, clicking the Go to start button always goes to frame 0, even
if the clip doesn't start at 0.
• BUG ID 47005 - Enabling Burn in the LUT in the Flipbook dialog uses the rec709 LUT for both
rec709 and rec1886.

Frame Server
• BUG ID 273472 - Canceling or pausing a comp render in the Background Renders panel displays
errors in the terminal.
• BUG ID 272523 - Non-contiguous frame ranges cannot currently be flipbooked.

GPU
• BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.
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Import Nuke
• BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command-line
arguments unavailable.
As a workaround, preserve sys.argv in another variable before you import Nuke.
• BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other
applications.
• BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is
available.

Linux Only
• BUG ID 271807 - Linux only: Adjusting pane or window borders left and right causes redraw lag.
• BUG ID 199990 - In some situations NVIDIA Quadro Linux drivers 319.23 can cause Nuke to hang
during start up.
As a workaround, update your drivers to 361.42.
• BUG ID 49262 - Scrubbing in the timeline in large projects can force memory use to hit 100%,
causing Nuke to become unresponsive.
• BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.
As a workaround, launch Nuke from the command-line using:
LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0
• BUG ID 42581 - Keyboard Shortcuts: Using Ctrl+C to quit Nuke from the command-line when a
dialog box is open displays an error.
• BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

LiveGroups
• BUG ID 274174 - Reloading a LiveGroup currently resets all edited User knobs.
• BUG ID 272281 - Adding a user knob and then undoing the action sets expression links to nodes
with matching names in main Node Graph.

Mac OS X/macOS Only
• Installation - If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA
CUDA drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers
directly from NVIDIA here:
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http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html.
• BUG ID 316577 - macOS only: Current localization progress does not update if the pointer focus is
on Nuke's menu bar.
• BUG ID 228076 - The PySide QtUiTools library is currently missing from the Nuke build.
• BUG ID 163543 - Mac OS X 10.11 only: Dragging handles in the 3D Comp Viewer can be slow to
respond.
• BUG ID 50371 - Script corruption can occasionally occur on Mac OS X 10.9 (Mavericks), and above,
when writing to SMB 2.1 and SMB 3 Sharepoint locations.
• BUG ID 50182 - Nuke cannot be launched from the Finder if it has already been launched from the
Terminal.
• BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.
• BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when
you click Save Report.
• BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than
one instance of Nuke at the same time, can cause display corruption and/or entire system freezes.
This seems particularly likely to occur on GPUs with low amounts of RAM, such as the GeForce GT
650M.
As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU
acceleration in one instance of Nuke at a time.
• BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure
X11 is installed on your system. Unlike previous versions of OS X, 10.8 and above do not have X11
installed by default.
For more information, see http://support.apple.com/kb/HT5293.
• BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.
As a workaround, either:
• tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or
Samba, depending on source), or
• using the command-line, copy the installation from Mac OS X to the network location using the
same file system as the destination.
• BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.
As a workaround, adjust the Viewer gain control to refresh the Viewer.
• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script,
except when Nuke is run from the command-line.
• BUG ID 13638 - The following graphics cards are not currently supported for Mac:
• ATI Radeon X1600
• ATI Radeon X1900
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Users with these cards are able to render from the command-line, but in GUI sessions, the Node
Graph renders incorrectly due to a requirement of OpenGL 2 drivers.
• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.
• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder
• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.
• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry
through a ScanlineRender node causes Nuke to crash.

Monitor Out
• BUG ID 250107 - Monitor Output: 10-bit output from Blackmagic DeckLink HD Extreme 3D+ cards at
the extents of color ranges is incorrect.
As a workaround, using the Desktop Video Setup utility, ensure that the SDI Settings 4:4:4 RGB
checkbox is enabled and the SDI Configuration is set to Single Link.
• BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash.
• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

OCIO
• BUG ID 201193 - Read node Metadata tabs occasionally include irrelevant in and out colorspace
controls.

Particles
• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to
geometry, does not render all frames to the .nkpc file.
• BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is
out-of-date errors for negative frame numbers.
• BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off
are not reliably cleared when rendering through ScanlineRender.
• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been
calculated within the particle system.
• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.
• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.
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• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind
the 3D grid lines.

Pixel Analyzer and Scopes
• BUG ID 44176 - PixelAnalyzer: The full frame sampling mode doesn't work immediately in the
timeline Viewer when the analyzer is initially added to the layout.
• BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the
Viewer bounding box to 1x1 for that frame.
• BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.
• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include
viewer color transforms is enabled.

PrmanRender
• In the Nuke camera, the window roll control is not yet mapped to RenderMan.
• BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plugin the environment.plist file when in GUI mode.
See http://support.apple.com/kb/TS4267 for more information.

Python
• BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes
Nuke to crash.
• BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when
run from the command-line.
Run the script from Nuke's Script Editor to avoid this issue.
• BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.
• BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the
command-line.
To work around this issue, run the Python script from Nuke's Script Editor.
• BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports
incorrect values.
As a workaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are
currently selected in the Node Graph.
• BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first
created if it has an autolabel.
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• BUG ID 8063 - Creating many new nodes with nuke.createNode() and the in-panel argument at
default (True) may crash when too many node control panels are created too quickly. The
workaround is to pass the in-panel argument as False or else use nuke.nodes.NodeClass() (where
NodeClass is the type of node to create) to create the node and then connect it to the currently
selected node manually.
• BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the
Script Editor as that can cause Nuke to crash. Instead, you can use the same command from your
menu.py, restore layouts by selecting Layout > Restore Layout, or use a custom menu or toolbar
item.
• Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:
groupName.NodeName.knobname: unexpected 'k' in '0.knobname'
The problem is most likely that there is an expression using the input TCL command and doesn't
validate that there is an input connected. An example expression:
[input parent 0].translate.x
The input command returns 0 when it can't find the requested input, which generates an expression
of '0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the
value TCL command and specify a default value to return in the case that the expression is invalid. It
takes the form:
[value [input parent inputnumber].knob defaultValue]
Here is the modified example:
[value [input parent 0].translate.x 0]
The modified example returns 0 in the event that there is no input 0, and no longer results in an
error message.
• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>()
if the knob is called 'in'.
For example, this gives a syntax error:
nuke.nodes.Shuffle(in = 'depth')
while this works because 'in' is a string here and not a keyword:
sh = nuke.nodes.Shuffle()
sh['in'].setValue('depth')
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RayRender
• BUG ID 230256 - Soft Shadows are not currently supported.
• BUG ID 197294 - Reflection occlusion is not currently supported.
• BUG ID 196980 - Clipped alpha shadows are not currently supported.
• BUG ID 196776 - Multiple bounce reflecton is not currently supported.
• BUG ID 196124 - RayRender does not currently support refraction.
• BUG ID 195051 - The Wireframe shader node, located in 3D > Shader > Wireframe, is not
supported by RayRender.
• BUG ID 195004 - Custom lens shaders/projection modes are not currently supported.
• BUG ID 194819 - RayRender does not currently support Deep workflows.
• BUG ID 191108 - Particle sprites are not currently supported.
• BUG ID 174849 - The Displacement shader node, located in 3D > Shader, is not currently supported
by RayRender.

Read and Write
• BUG ID 50046 - The default colorspace values when writing using .mov codecs differ in commandline and GUI modes.
• BUG ID 48935 - MXF: Importing a certain JPEG2000 file causes Nuke to crash or display the file
incorrectly.
• BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.
• BUG ID 47248 - MXF: Setting debayer quality to High Quality on some Sony RAW files displays an
error decoding frame message in the Comp Viewer.
• BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the
rgba channels by default.
• BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.
• BUG ID 40684 - Rendering certain h264 encoded .mp4 files using the mov32 encoder results in color
shifts using QuickTime 10.3 codecs.
• BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to
ProRes 4444.
• BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes
correctly.
• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect
while toggling the read transform from file in combination with all objects and/or read on each
frame.
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• BUG ID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a
superfluous main view.
• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to
neighboring faces, leaving gaps in certain circumstances.
This issue is particularly visible when using the EditGeo node, which should not allow you to remove
faces from the geometry.
• BUG ID 31424 - Sub-sampling in .exr files is not currently supported.
• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc
files.
As a workaround, ensure that ReadGeo > read on each frame is enabled.
• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new
views to the project, subsequent reads of any stereo/multiview .exr files won’t give the option to add
new views.
• If you have trouble with FBX files, it may be because they were written with an older version of FBX.
If they load very slowly, it is also possible that they are ASCII rather than binary. To get around these
problems, you can use the FBX converter on the Autodesk website. It converts between various
different formats, including older FBX versions, ASCII, and binary, and is available on Windows, Mac
OS X, and Linux.
To download the FBX converter:
1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775855.
2. Scroll down to FBX Converter and click on one of the links to start the download.

Render codecs
Rendering with certain codecs occasionally causes Nuke to crash. Due to this, we recommend the
following:
• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec
instead. If you're unable to switch to Sorensen Video 3, try using a format smaller than 2K for better
performance.
• If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or
above. You may need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx.
• If you're using Avid Meridien, you should only write out in NTSC and PAL.
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Roto/RotoPaint Open Splines
• BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the
feather handles in the Viewer.
• BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.
As a workaround, select the shape and then manually change the Properties view control to include
both views.
• BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.
• BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative
feather values.
• BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave
erratically.
• BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects
in the hull or feather.
• BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally
produces artifacts in the spline's hull.
• BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is
set to 0.
• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.
• BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight
rendering glitches inside the hull.
• BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width
changes greatly from one point to the next
• BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open
Spline and Bezier tools.

Other Roto/RotoPaint Bugs
• BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint
color.
• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo
the keyframe creation.
• BUG ID 32450 - RotoPaint Stereo: Attempting to undo multiple split-control transforms on the same
shape reverts the shape to its original position.
• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t extend to the current frame,
disappear when drag-selected.
As a workaround, select the shape in the curves list to re-display the points.
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• BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected.
NOTE: This also applies to SplineWarp matrices.
• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent
shapes for a single smooth operation.
• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.
• BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke
8, but bear in mind that they won’t be backwards compatible with Nuke 6 once converted, unless
you follow the instructions below:
Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:
• Click Save As to convert the script to the Nuke 8 Roto format, or
• Click Ignore to load the Nuke 6 format into Nuke 8. You might select this option if:
- You don't intend to make any changes, or
- You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.
If you want Nuke 8 scripts to load in Nuke 6, use the convertToNuke6 or
convertDirectoryToNuke6 Python functions when running Nuke 8 in command-line only mode:
NOTE: The conversion functions cannot convert stereo-split curves as they are not
supported by Nuke 6.
• To convert individual .nk scripts:
convertToNuke6(fromScript, toScript, overwrite = False)
• To convert all .nk scripts in a given directory:
convertDirectoryToNuke6(fromDir, toDir, matchPattern =.*\.nk, overwrite =
False)
NOTE: The pattern is a regular expression.
An example single script conversion and rename to the same directory, from the command-line (or
Terminal):
$ <NukeInstallDir>/Nuke8.0v1 -t
>>> import nuke.rotopaint
>>> nuke.rotopaint.convertToNuke6(/tmp/myRoto8.nk, /tmp/myRoto6.nk)
• BUG ID 26855 - The undo and redo buttons in the Properties panel didn’t work as expected and
have been disabled.
The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the
Edit menu instead.
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• BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another
frame.
• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.
• BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of
the screen.
• The foreground onion skin overlay updates as you paint, rather than only updating with the new
stroke on pen up.
• It is not currently possible to clone RotoPaint nodes.
• Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled
on the layer you are working in.

ScanlineRender
• BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.
• BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in
semi transparent areas.
• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an
image.

SmartVector Toolset
• BUG ID 275683 - SmartVector: Due to VFX Platform library changes, vectors generated by the Nuke
11 SmartVector toolset do not match legacy versions. For example, vectors generated by Nuke
11.0v1 do not match those generated by Nuke 10.5v4.
• BUG ID 196455 - Rendering vectors after correcting the file control in the SmartVector node
occasionally displays a spurious No such file or directory error.
As a workaround, scrub to a different frame to remove the message.
• BUG ID 175605 - Entering a partial file path in the SmartVector file control and then clicking the file
browser icon does not open the file browser.
As a workaround, click OK on the error message and then click the file browser icon again.

Text
• BUG ID 48418 - Different operating systems handle the Shadows tab shrink/expand control
differently, producing inconsistent output.
• BUG ID 39556 - In text edit mode, it is not currently possible to edit text attributes when the Viewer
overlay is disabled.
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• BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does
not work as expected.
As a workaround, expression link the translate x and y controls separately.
• BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.
• BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame
where the character no longer exists, results in the transformation being lost.
• BUG ID 39130 - Splitting the message field does not work as expected.
• BUG ID 38789 - Viewer toolbar controls steal cursor focus.
• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.
• BUG ID 36372 - Selecting a TCL expression in the message field doesn't always select the result in
the Viewer.

Tracker
• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back
the tracked frames.
As a workaround, you can enable full frame processing, though this may increase render times.
• BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the
tracking anchor coordinates to 0,0.
• BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.
• BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection.
• BUG ID 38356 - The zoom window occasionally doesn't update correctly when scrubbing between
frames.
• BUG ID 32359/32353 - Right-clicking on a point in the Viewer doesn’t always update the available
Link to > Tracker linkingdialog or Tracker options.
As a workaround, close and re-open the Roto/RotoPaint properties panel to update the Link to
menu.
• BUG ID 29382 - Tracking keyframes with different sized patterns doesn’t work as expected.
As a workaround, keyframe patterns should, where possible, be of comparable sizes.

VFX Platform
• You may experience issues when importing PySide modules into their Python scripts due to the
migration from PySide 1.2.2 to PySide 2.0.
In some cases, you can just change calls to:
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import Pyside.some_module
to:
try:
import Pyside.some_module
except:
import Pyside2.some_module
However, the definition of some classes has moved between modules in PySide 2.0. This particularly
affects any Widget related classes, which have been moved from QtGui to QtWidgets, however there
are other cases where this may be experienced.
If you experience any problems with this, please refer to the Qt 5.6.1 documentation, or contact
support.foundry.com.
• BUG ID 282593 - Switching to a fullscreen workspace on the primary monitor occasionally causes
the secondary monitor to turn black.
• BUG ID 280371 - Mac OS X/macOS only: OpenGL errors are printed on the command line when
using an ATI Radeon 5770 GPU.
• BUG ID 277875 - VFX Platform: Switching workspace occasionally draws the new workspace
incorrectly.
• BUG ID 277548 - A QComboBox with a custom QCompleter currently emits incorrect signals.
• BUG ID 275719 - Mac OS X/macOS only: The Help > About Nuke pop-up is positioned incorrectly on
some machines.
• BUG ID 275251 - Mac OS X/macOS only: Hovering over clip instances in the timeline does not change
the pointer icon.
• BUG ID 275246/270914 - The terminal or command line displays libpng warning: iCCP: cHRM
chunk does not match sRGB on start-up.
• BUG ID 274301 - Node toolbar menu items do not always deselect correctly.
• BUG ID 274264 - CameraTracker results from Nuke 11.1 are not identical to previous versions of
Nuke, though the differences are negligible.
• BUG ID 272767 - Launching Nuke from the terminal with the -b argument has been deprecated as a
result of library upgrades to comply with the VFX Platform 2017 requirements. There are two
workarounds available on Mac and Linux :
• Run Nuke from the Terminal with & added to the launch command. This allows Nuke to run in
the background and returns the command prompt, but closing the Terminal still causes Nuke to
close. For example:
./Nuke11.1v1 --studio &
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• Run Nuke from the Terminal using the nohup command. This allows Nuke to run in the
background and returns the command prompt, but closing the Terminal does not cause Nuke
to close. For example:
nohup ./Nuke11.1v1 --studio &
TIP: The nohup command prints output to /Users/<username>/nohup.out or
/home/<username>/nohup.out by default, but you can specify a different file by appending
> /filepath/filename to the command. For example:
nohup ./Nuke11.1v1 --studio & > /Users/<username>/nuke.out
• BUG ID 272750 - The remove all panels button in the node Properties panel is displayed
inconsistently.
• BUG ID 272504 - The timeline Viewer in and out point previews are not working as expected when
scrubbing.
• BUG ID 272442/281108 - The Licensing dialog jitters when moved around the screen.
• BUG ID 272338 - The Windows command prompt displays QWidget::paintEngine: Should no
longer be called on launch.
• BUG ID 272274 - Closing Nuke Studio does not remove the application icon from the task bar.
• BUG ID 271632 - Nuke prints a libDeckLinkAPI.so error in the terminal on launch.

Warpers
• BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display
an overlay until pen-up.
• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points
to 0,0, which cannot be undone.
• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are
removed.
• BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot
currently be undone.
• BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to
a new layer.
• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.
• BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to
display the cropped image and the black area between the crop box and the format when merged
over a background.
• BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid
lines.
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• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect in morph mode, when mix is set
at an intermediate value.
• BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes
rendering problems.
• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when in morph mode
with mix set at an intermediate value.
• BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather
than just the latest, and the keyframes remain on the timeline and in the properties.
• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.
• BUG ID 19079 - SplineWarp: The C keyboard shortcut does not currently select the Add
Correspondence Point tool.
• BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes,
even if a grid is not visible in the Viewer.
• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different
positions, does not undo as expected.
• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or
Dope Sheet.
• BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new
grid using the Draw Boundary Viewer button.
• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A
shortcut.
• BUG ID 18012 - GridWarp: The grid can flicker between white and gray when zooming in and out of
the Viewer, particularly when the grid is subdivided.
• BUG ID 17697 - GridWarp: In stereo mode, the right view is labeled as default when you split
controls into separate views.

Windows Only
• Nuke Non-commercial: Navigating to Help > License, clicking Deactivate or Deauthorize, and then
clicking Quit, causes Nuke Non-commercial to crash on exit.
As a workaround, change the mode a few times until it work as expected.
• BUG ID 198430 - Nuke cannot read DNxHD .mxf files that have spaces in the file name.
• BUG ID 46759 - File Browser: Location defaults (such as Home, Root, etc.) may not display if you
have a previously saved FileChooser_Favorites.pref file in your ~/.nuke directory.
As a workaround, move or rename the FileChooser_Favorites.pref file, and re-launch Nuke.
• BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you
use the erase end of the pen.

RELEASE NOTES
20

Release Notes for Nuke and Hiero 11.2v3 | Other Known Issues

• BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422
(2vuy) pixel format due to a bug in the codec, resulting in solid green frames.
As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity.
• BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node,
such as Primatte or Shuffle, even after the node is removed from the Node Graph.
• BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous
• BUG ID 339241 - MatchGrade: Clicking Analyze Reference Frames with a Read node with no valid
file path displays an Uncaught C++ exception occurred during the execution of python script!
error.
• BUG ID 312350 - Visual Diagnostics: The Profile tab occasionally flickers when the application
window is maximized.
• BUG ID 309259 - Documentation: The Python Developers Guide incorrectly references Qt 4.8.5
source code.
For links to the correct source files, see the Nuke Developers page under Nuke Qt binaries and
source files: https://www.foundry.com/products/nuke/developers
• BUG ID 273462 - Licensing: Nuke cannot retrieve a license from the license server when the
hostname contains .local.
• BUG ID 272296 - Adding a user knob and then undoing the action doesn't remove the added knob.
• BUG ID 271804 - Documentation: The node Properties panel ? link to the reference documentation
doesn't work as expected.
• BUG ID 271456 - UI: Some interface elements appear larger than usual when compared to previous
versions of Nuke.
• BUG ID 271256 - Denoise: Rendering frames to disk with a Temporal Frame Offset greater than 1
causes Nuke to crash.
• BUG ID 271074 - PointCloudGenerator: Track Points does not work as expected when creating a
point cloud from CameraTracker data.
• BUG ID 228258 - Calling fromScript() on a knob that has not been added causes Nuke to crash.
• BUG ID 226394 - Preferences: There are currently duplicate Script Editor controls under Other in
the Preferences dialog.
• BUG ID 169458 - Compositing Viewer: Setting the gamma control to 0 with Panels > Viewer (Comp)
> use GPU for Viewer when possible enabled in the preferences, renders the alpha channel black.
• BUG ID 168350 - AMD GPUs are reported as ATI GPUs in the node properties and --gpulist on the
command line.
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• BUG ID 50715 - ZDefocus: Switching the filter type to image causes Nuke to crash in a customer
script.
• BUG ID 49803 - AJA Monitor Output: Setting the NUKE_AJA_CHANNEL environment variable to 4
when the NUKE_AJA_DUALOUTPUT environment variable is set, streams the output to SDI3, rather
than SDI4.
• BUG ID 49186 - ColorCorrect: Adding an expression to the curves on the Ranges tab and then
changing a value, such as Gain, causes Nuke to crash.
• BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is
changed.
• BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system
occasionally allows particles to pass through the bounce surface.
• BUG ID 42339 - The Modo Viewer control scheme (Preferences > Panels > Viewer Handles > 3D
control type) does not work as expected.
• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel
doesn't work as expected.
• BUG ID 42159 - Nodes that use the Iop::sample() call to get input pixels, such as LensDistortion,
perform poorly when they are downstream of nodes using PlanarIop, such as Denoise.
• BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.
• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the
same name as the file path to the original.
WARNING: If you save this empty script when the network drive is reconnected, the original
is overwritten.
• BUG ID 41122 - MatchGrade: Match Different Clip mode does not allow you to set keyframes on
the Target for .mov clips with a frame range offset.
• BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous
versions.
• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middlemouse button, pastes values into the control.
• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the
Nuke<>Mari bridge won't work unless all instances of Project3D are renamed appropriately in the
mari_bridge.py file.
• BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links.
• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the
nodes from the Node Graph.
• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.
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• BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format
sizes causes corruption and constant refreshing in the Viewer.
• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.
• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the
script, resulting in error when the path doesn't exist:
Flipbook render failed: viewerCaptureOp: Cannot write to specified path
• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the
captured images.
• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when
mousing over the Viewer.
• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.
• BUG ID 32628 - DeepToPoints: Command-line rendering appears to calculate renders even when
render is set to off.
• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and
Hiero.
• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output
layer produces corrupt output.
As a workaround, shuffle the depth information to an alternate layer.
• BUG ID 32118 - Card3D: When motionblur is enabled in the properties, FrameHold and TimeOffset
nodes are ignored when connected to the cam or axis inputs.
• BUG ID 31803 - Using Shift+drag on a control’s animation icon only copies the value for the current
frame, not the entire expression.
• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual
bounding boxes for polymesh primitives.
• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes.
• BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it’s unique identifier,
causes the cache to release. Actions such as adjusting the Viewer Gamma, Gain, or channels
dropdown affect the frame hash.
• BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.
NOTE: This known issue only applies to Roto and SplineWarp keys.
• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the
node is copy/pasted in the Node Graph.
• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.
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• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a
Scene node only displays the animated Camera in the Viewer. There should be two cameras: one
static and one animated.
• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal
length of the new camera does not match that of the Viewer camera.
• BUG ID 28291 - Nuke crashes on start up if the disk cache location set in the Preferences is no
longer available.
• BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the Viewer with the control panel
open.
• BUG ID 20204 - Multitexturing: When Preferences > Viewers > Multiframe is enabled, increasing
downrez in the Viewer toolbar can cause textures to flicker in the 3D Viewer.
You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.
• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the
Viewer.
• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch
in the Properties panel.
• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.
• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because
some large polygons are clipped by the front camera plane.
You can minimize this effect by increasing the geometry tessellation max parameter.
• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or
zooming.
• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and
points drawn with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and
the other in 3D mode, and you have the panel for the RotoPaint visible.
• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit
per frame is 50MB. If your frames are larger than this, you may need to switch to proxy mode for
the caching to work.
• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is
not restricted to, any nodes that have an analysis pass.
• BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.
Nuke runs correctly from a network install on Windows without specifically installing the run-time
libraries, though we still recommend that you do so as there are still some minor problems without
them.
• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render.
This question is unnecessary as the result is an anaglyph image. Irrespective of what view you
choose, the flipbook output is the same.
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• File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so
if you save a script on NukeX using features that are only included in NukeX (such as CameraTracker
or FurnaceCore) and then double-click on the script icon to open it, it opens in standard Nuke
instead of NukeX.
• CameraTracker: Canceling lens distortion initialization results in corrupt tracks.
• 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node
when using Create Scene:
• Select the Camera that was created in the 3D view when using the Create Scene button.
• Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to
focus (using F) on the point cloud. The resulting tumble camera movement is likely to be jumpy.
• Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were compiled
against an earlier version of Nuke.

Known Issues Specific to Nuke Studio and Hiero
AAF
• BUG ID 274824 - Elastic keyframes imported from Avid do not translate correctly into Nuke Studio.

Create Comp
• Multi-view, such as stereoscopic, is not supported for clip instances created using right-click Effects
> Create Comp.
• BUG ID 47044 - Inserting scripts into comps containing Text nodes using unsupported fonts causes
Nuke Studio to crash when the Text nodes are disabled.
• BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the
comp frame range compared to the annotations precomp frame range.
• BUG ID 41665 - There are currently no options to load or overwrite an existing script when you
select Create Comp.

Exporting
• BUG ID 49024 - Enabling the Collate... options in the Export dialog when exporting ignores the
Media tab Output Resolution setting for the track above, and produces output with incorrect
formatting.
• BUG ID 47828 - Exporting retimed or reversed clips as .xml does not work as expected when
imported into Final Cut Pro.
• BUG ID 46403 - Controls set in the Export dialog Content tab occasionally default to the values
from the Nuke Write Node Content preset.
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Linux Only
• BUG ID 282599 - Linux only: Input and timecode metadata is currently incorrect in the timeline
Viewer if the framerate is changed.
• BUG ID 239672 - Reading files from NTFS disks/partitions can be extremely slow, particularly for
large files. This is a limitation of Linux NTFS file systems, rather than Foundry products.
We recommend avoiding timeline playback that relies on source footage from NTFS
disks/partitions.
• BUG ID 235327 - CPU usage can reach 100% on a single thread during flipbooking, causing Nuke to
become unresponsive.
• BUG ID 167058 - PulseAudio (ALSA) can cause Nuke Studio to crash or impair playback.
As a workaround, you can stop the pulseaudio daemon:
1. Open /etc/pulse/client.conf
2. Set autospawn = no and daemon-binary to /bin/true. Ensure these lines are not
commented out.
3. Call ps -e | grep pulse to check the process is still running.
4. Call pulseaudio --kill
5. Call ps -e | grep pulse again to check the process has stopped.
• Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio
on Linux is scheduled for a later release.
• BUG ID 32613 - Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes
Nuke Studio to crash.
As a workaround, ensure that you have the latest NVIDIA drivers installed, available from:
www.nvidia.com/Download/index.aspx?lang=en-us

Mac OS X/macOS Only
• BUG ID 39113 - QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and
earlier.
This is a codec issue rather than an application issue.
• BUG ID 34779 - The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to
a conflict with the combination for the umlaut symbol.
To work around this, press U momentarily before Alt+U.
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OCIO
• BUG ID 198348 - Saving and closing a project that uses an OCIO config, and then relocating the Nuke
install path, causes a Could not load OpenColorIO config error on reload.

Preferences
• The Preferences > Path substitution table for cross platform compatibility currently only comes
into effect at project load, not EDL/XML import.
As a workaround, import your sequence and set the Path substitution rule, then save the project
and reload to force the conversion.

Python API
• BUG ID 50113 - QActions are not added to the Edit menu in the menu bar when finding the menu
action by name.
As a workaround, use the objectName (foundry.menu.edit), where possible.
• BUG ID 44394 - Calling hiero.core.addPathRemap() does not work for soft effect file paths.

Read and Write
• BUG ID 278312 - Read/Write: The import progress bar occasionally persists after the import is
complete, and cannot be closed.
As a workaround, save and close the project, then restart Nuke Studio and reload the project.
• BUG ID 49912 - HieroPlayer: Projects created in version 1.9, or earlier, are not editable in
HieroPlayer 9.0.
• BUG ID 46174 - XML: Shot names are occasionally not imported correctly from Adobe Premiere .xml
files.
• BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the
Rendering preference set to limit renderer.
As a workaround, you can change the preference Performance > Threads/Processes > Rendering
> export renders to no renderer limits to improve rendering speeds. You can also experiment
with the custom renderer limits to adjust performance on your machine.
• BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.
• BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.
• BUG ID 36726 - Executing Clip > Rescan Clip Range displays frame read errors if the rescan adds
frames to the clip.
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• BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to
other applications, such as Premiere or Resolve.
• BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default
Nuke layer, such as depth or motion.
• BUG ID 28067 - Certain formats produce no monitor output, such as 2K 23.98 and 720P 25.
• BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when
added to the timeline.

Soft Effects
• BUG ID 280413 - Soft Effects: The Text effect cursor placement shifts incorrectly after typing first
character.
• BUG ID 278275 - Soft Effects: Closing a Timewarp effect's Properties panel disrupts the interface
briefly.
• BUG ID 275314 - Soft Effects: Additional keyframes are added incorrectly when animating Text
effects.
• BUG ID 230536 - The Burn-in effect does not maintain a constant text baseline for all characters
when the format is changed.
• BUG ID 175574 - Undo and redo of Properties panel changes can be unreliable if a soft effect delete
is in the same undo stack.
• BUG ID 50442 - TimeWarp: Applying a TimeWarp to a clip instance occasionally causes the
associated sequence bin item to display an error.
• BUG ID 50441 - TimeWarp: Applying a TimeWarp to clip instances retimed to values other than 100%
does not work as expected.
• BUG ID 49771 - Text/Burn-in: Nuke Studio doesn’t warn you if the font used in an effect could not be
found.
• BUG ID 49298 - Burn-in: The Burn-in effect does not auto-update when switching between
sequences until the playhead is moved.
• BUG ID 49112 - Dissolve transitions do not work as expected in Custom soft effects, based on the
examples provided here:
<install_directory>/pythonextensions/site-packages/hiero/examples/custom_
soft_effect.py
• BUG ID 48970 - Burn-in: Burn-in elements are not updated automatically when the underlying
metadata is updated.
As a workaround, either change the frame displayed in the Viewer or choose an alternate element
from the dropdown controls.
• BUG ID 48878 - Burn-in: The Burn-in effect is currently a gizmo and cannot be cloned on the
timeline.
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• BUG ID 48098 - Adding a transition when a Text effect containing an expression is on a track above,
causes text rendering to fail during the transition.
• BUG ID 48097 - Adding a transition when a Text effect containing an expression is on a track above,
causes the text size to reset.
• BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression
writes incorrect frame numbers.
• BUG ID 45835 - Expression links are incorrectly allowed between node and soft effect controls in the
Properties panel, if the node and effect names are identical.
• BUG ID 42438 - Effects are only visible in the Viewer if there is a clip instance below them in the
timeline.
• BUG ID 42401 - Renaming a soft effect does not update the clip instance until you click in the
timeline.
• BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available
using the toolbar button on the timeline panel. The right-click Effects menu is currently disabled.

Timeline
• BUG ID 43913 - Locking a track currently prevents adding clip instances from the locked track to the
Viewer input buffers. You can still open clip instances in the various right-click Open In options and
access clip instance metadata.
• BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below
existing tracks.
As a workaround, drag the clip to a new top-level track and then manually move the track to the
required position.
• BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the
right-click Open in Timeline option.

Timeline Disk Caching
• BUG ID 280256 - Opening a Text effect's Properties panel directly after project load causes the
cache bar to disappear.
• BUG ID 272897 - Caching continues after closing the project associated with the frames being
cached.
• BUG ID 270934 - The caching logic does not currently account for gaps in sequences, resulting in the
caching state icon remaining gray for fully cached sequences.
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Timeline Read Nodes
• BUG ID 313013 - Opening the Node Graph from the Project bin and then returning to the timeline
environment behaves as if the left mouse button is held down.
As a workaround, left-click in the timeline to cancel the mouse press.
• BUG ID 310067 - Loading large projects is currently slower than expected.

Windows Only
• BUG ID 314088 - Localization: The first frame of localized files in the outdated state, colored red, do
not always update correctly.
• BUG ID 49339 - Soft Effects: The background on Burn-in effects, when enabled, alters size
depending on the timecode displayed.
• BUG ID 28701 - Nuke Studio cannot currently parse Unicode characters during export.

Miscellaneous
• BUG ID 313849 - Localization: Reading certain multiview .exr files causes Nuke to crash.
As a workaround, rename or move your .nuke folder and re-launch Nuke to refresh the uistate.ini
file.
• BUG ID 272723 - Closing Nuke Studio when it was launched from the command line does not end all
Nuke processes.
• BUG ID 200015 - Selecting multiple bin clips can cause the right-click menu to respond slowly.
• BUG ID 167919 - Localization: Re-importing clips into the Node Graph or project bin multiple times
retains the original localization policies settings.
• BUG ID 50490 - Audio: Zooming in on a waveform displays a Failed to decode audio error in the
timeline.
• BUG ID 50102 - Adding a custom Hiero window to a workspace and then saving it as the Nuke
default workspace causes Nuke to crash on start up.
• BUG ID 46235 - Comps with relative paths are not currently working when imported into the project.
• BUG ID 42462 - Cache pausing stops working if any change is made to the timeline.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/111/ndkdevguide/appendixc/index.html for more
information.
As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.
Release Type

Example

Compatibility

Version

10.0v1 to 10.0v2

API and ABI

Point

10.0v1 to 10.5v1

API

Major

10.0v1 to 11.0v1

-

Recompile

Rewrite

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.
As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features
There are no new features in this release.

Feature Enhancements
There are no feature enhancements in this release.
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Bug Fixes
• BUG ID 358937 - Python: Creating a Tab_Knob in the Script Editor caused Nuke to crash.
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Release Date
23 July 2018

Qualified Operating Systems
• macOS Sierra (10.12) or macOS High Sierra (10.13)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)
Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration
If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.

NVIDIA
An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.
NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.
With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA
GPU. Driver version r361 or above is required.
Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you
don't have it already. The minimum requirement is driver version r361 which can be downloaded
from www.nvidia.com/drivers.
NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

AMD
• On Windows and Linux, an AMD GPU and driver from the following list:
Windows GPU

Driver

Linux GPU

Driver

AMD FirePro W8100

17.Q2.1

AMD FirePro W8100

17.Q2.1

AMD FirePro W9100

17.Q2.1

AMD FirePro W9100

17.Q2.1

AMD Radeon R9 Fury X

17.4.3 - 17.6.2 AMD Radeon R9 Fury X

17.10

AMD Radeon RX 480

17.Q2.1

17.Q2.1

AMD Radeon RX 480

AMD Radeon Pro WX 7100 17.4.3 - 17.6.2 AMD Radeon Pro WX 7100 17.10

NOTE: Other AMD GPUs may work, but have not been fully tested.
• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016
MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

Mac GPUs
Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and
late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multiGPU support option. When enabled in the preferences, GPU processing is shared between the
available GPUs for extra processing speed.
NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend
updating Mavericks to 10.9.5, or above for full functionality. However:
• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.
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• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
Improved Tab Menu
The Node Graph's tab menu has been improved, including a new search algorithm, allowing you to
search for and add nodes more easily using partial names. Commonly used nodes are weighted so
that they appear higher up the list of choices and you can also favorite nodes, pinning them to the
top of the list with the star icon. Weights and favorites can be enabled, disabled and cleared in
Preferences > Behaviors > Nodes. The J Bookmarked nodes menu also supports the updated
search functionality.

New Interface for User Knob Creation
Also known as Drag-and-drop knobs (DnD), this update significantly reduces the time spent exposing
user knobs and adding custom knobs to node properties panels within Nuke. As a result, you can
create and modify gizmos and Live Groups more easily, stream-lining collaborative workflows.
Instead of right-clicking and selecting Manage User Knobs, simply click the edit button at the top of
the Properties panel to get started. You can drag-and-drop knobs between open node panels or add
your own using the knob icons listed at the top of the panel. You can also order, hide, customize, and
delete knobs within the Properties panel. If you work with floating panels, you can float the User
Knob Editor too. Click the edit button again to finish customization.

Nuke Studio Project Panel Improvements
These are a number of enhancements to the way you can organize, manage and, navigate through
your projects in Nuke Studio. These enhancements also apply to the spreadsheet and the timeline.
• New Sorting - a new way to arrange your project bin alphabetically or by custom order. This is
accessible through the new buttons at the top of the Project panel and it has controls for the
hierarchy view and on the bin view independently.
• Improved Searching - improved search functionality on the Project panel and on the spreadsheet
with new options to search all metadata or not, and to use all or any of the input string.
• Poster Frame - a new poster frame functionality allows you to set the poster frame for your source
clips and shots. You can set it for single or multiple source clips using absolute or relative frames,
which is useful when you have shots with slates or black handles.
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• Color Assignments - you can now assign colors to your source clips, shots, and spreadsheet events.
You can also set colors based on file types.

Smart Vector Toolset Improvements
The Smart Vector Toolset in NukeX has several improvements that speed up the generation of vectors
and extend the use cases where the toolset can be used.
• GPU Acceleration - the SmartVector and VectorDistort nodes have been rewritten to make the best
use of the GPU, dramatically reducing the time it takes to both create the smart motion vectors and
use them to warp images.
• Mask Input to SmartVector - you can now supply a mask to the SmartVector node to specify
regions containing unwanted objects or motion to help with handling occlusions and image
boundaries.
• Background Vector Rendering - you can now render vectors in the background using the Export
Write button.

File Localization API Extension
Building on the updates to the localization system in Nuke 11.1, the system has been further
extended to provide greater control over customization through new callbacks. We have also added a
new environment variable, NUKE_LOCALIZATION_NUMWATCHERS, to improve performance when
checking the validity of localized files, especially when working with scripts with a high number of
Read nodes or a high number of frames.

Additional Python callbacks:
The following Python callbacks have been added, giving further control over files and Read nodes as
they are added to the queue to be localized and transition between being out-of-date and localized.

Callback functions executed on each file’s localization event:
• localization.FileEvent.ADDED
• localization.FileEvent.REMOVED
• localization.FileEvent.OUT_OF_DATE
• localization.FileEvent.CACHE_FULL
• localization.FileEvent.DISK_FULL

RELEASE NOTES
36

Release Notes for Nuke and Hiero 11.2v2 | New Features

Callback functions executed on each Read nodes localization event:
• localization.ReadStatus.NOT_LOCALIZED
• localization.ReadStatus.LOCALIZING
• localization.ReadStatus.PARTIALLY_LOCALIZED
• localization.ReadStatus.LOCALIZED
• localization.ReadStatus.OUT_OF_DATE
• localization.ReadStatus.LOCALIZATION_DISABLED

Auto switch from localized to network files:
A new preference, read source files when localized files are out of date, has been added. When
enabled, Nuke checks the localized files against the source files and switches to their source files if
the local files become out of date.

Control over the number of simultaneous file checks:
A new environment variable NUKE_LOCALIZATION_NUMWATCHERS controls the number of
simultaneous file checks, improving performance when working with large scripts over a high
capacity network. We have found that checking the status or force-updating a large number of reads
or large sequences could create a bottleneck as Nuke evaluated the files. To improve this we have
added an option to increase the number of file checks that can occur at once to expedite this process
with an appropriate network configuration.

ARRI SDK Update
ARRIRAW has been updated to version 5.4.3.5, adding the following features:
• Alexa LF formats and color tables
• Rec2100/PQ and Rec2100/HLG HDR colorspaces
• Extended white balance CC values from -16 to +16
The full ARRI SDK release notes are publicly available from:
http://www.arri.com/support/downloads/searchable_downloads/

R3D SDK Update
R3D SDK has been updated to version 7.0.6, adding the following features:
• R3D Weapon Monstro 8K VV and Helium 8K S35 Sensors
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• ImageColorDCIP3, ImageColorProPhotoRGB, ImageColorDCIP3D65 colorspaces
• ImageGammaHybridLogGamma, ImageGamma2_2, ImageGamma2_6 Gamma Curves
NOTE: Support for IPP2 will be available in a future release.
The full R3D SDK release notes are publicly available in the SDK download from:
https://www.red.com/developers/

New Deep Compositing API
Nuke has a new API for Deep Compositing, which manages memory more efficiently resulting in
improved performance for some nodes. Nuke’s native deep compositing nodes have been converted
to this new API and in our tests, scripts are processed up to 1.6x faster compared to Nuke 11.1.
Performance improvements vary by node and set up; for example, DeepRecolor and DeepTransform
show the best gains, while DeepColorCorrect has little improvement.
To take advantage of these performance improvements, custom deep nodes need to be converted to
the new API. Existing custom nodes still work in Nuke 11.2, defaulting to the pre-existing API, but will
not have any improvement to performance.
Details on the API changes and converting custom nodes are available in the NDK Developer Guide.

Deep Compositing Improvements
In addition to the new API, Nuke 11.2v1 includes a number bug fixes and improvements to the deep
compositing tools including the DeepExpression node having functional parity with Nuke’s standard
Expression node.
Workflows using metadata have also been added to Nuke’s Deep nodes. Metadata nodes
(ModifyMetadata, ViewMetadata, CopyMetadata, and so on) can now be used in a tree with Deep
nodes.
The DeepMerge node has been updated to allow you to use metadata from either the A input, the B
input, or both.
NOTE: 2D nodes should not be inserted in between Metadata nodes within a deep stream.
The Viewer must be connected to a Deep node rather than a Metadata node in order to view
the output of deep streams.
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End User License Agreement
This release of Nuke includes a new version of the End User License Agreement (EULA), available
here.

Feature Enhancements
• BUG ID 134441 - Deep: The functionality of the DeepExpression node has been expanded to match
the standard Expression node.
• BUG ID 139582 - Deep: The Preferences dialog now includes a control to choose the connector
color between Deep nodes under Panels > Node Graph > Arrow.
• BUG ID 151165 - DeepWrite: Only Zip1 compression is supported for .exr output. The other options
have been removed.
• BUG ID 158323 - Deep: A new control, target input alpha, has been added to the DeepRecolor
node. When enabled, the color input’s alpha is distributed among the samples so that the final
resulting alpha after flattening of the deep data matches the color input’s alpha.
• BUG ID 163251 - Deep: The nodes listed under MetaData in the nodes toolbar now work in Deep
node trees.
• BUG ID 196909/196912/196941/197559 - SmartVector: Render progress bars and error reporting has
been improved.
• BUG ID 196839 - Deep: A new deep option has been added to the DeepRecolor node's set bbox to
control, allowing you manage bounding boxes between deep and standard nodes.
• BUG ID 219397 - SmartVector: A new control, Flicker Compensation, has been added to the
Properties panel. When enabled, SmartVector compensates for luminance changes in the source
image when calculating vectors.
• BUG ID 278255 - Localization: You can now use Cache > Localization > Force Update > Selected
on nodes when Localization is paused.
• BUG ID 333431 - Mac OS X/macOS only: Nuke now supports AMD Radeon Vega GPUs.
• BUG ID 345759 OCIO: The Log3G10 LUT has been added to Nuke's standard LUTs list.

Bug Fixes
• BUG ID 136654 - R3D: Certain single frame .r3d files beginning on frame 0 were interpreted
incorrectly as starting on frame 1.
• BUG ID 142813 - Deep: Executing a script in terminal mode that read in a Deep image then wrote it
to disk caused Nuke to crash.
• BUG ID 145272 - Node Graph: The Tab menu included a @;&<node>Branch entry incorrectly.
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• BUG ID 145308 - DeepSample: Particles employing sprites caused the deep.front and deep.back
channels to display Inf values in a customer script.
• BUG ID 148823 - Nuke Assist: Nuke scripts containing Keylight or FurnaceCore nodes checked out a
nuke_i license.
• BUG ID 150961 - Deep: It was possible to connect Framehold nodes to Deep nodes, even though
they did not function.
• BUG ID 154977 - Deep: The DeepColorCorrect node culled samples incorrectly.
• BUG ID 161956 - Deep: The DeepExpression node did not clamp output in the same way as the
standard Expression node.
• BUG ID 161979/328288 - Deep: The DeepRead node set the width and height controls to 1 under
the correct value.
• BUG ID 168261 - Deep: Copying and pasting DeepExpression nodes discarded control values.
• BUG ID 174062 - Documentation: It was not clear in the documentation that Nuke scales non-HD
DNxHD output to 1080p.
• BUG ID 196487 - Documentation: The port range of local Frame Server processes was missing from
the documentation.
• BUG ID 196940 - ARRIRAW: The uuid metadata for media.arri.camera displayed incorrectly.
• BUG ID 201586 - Mac OS X/macOS: The Restore Snapshot function did not work as expected.
• BUG ID 202223 - Deep: DeepWrite nodes included several unusable EXR compression options.
• BUG ID 221568 - Deep: Enabling specify z in the DeepFromImage Properties panel caused
DeepWrite nodes to output corrupt data.
• BUG ID 251544 - Monitor Output: Switching from Active to A/B mode with Full Resolution Stereo
selected caused the monitor to display multiple images incorrectly.
• BUG ID 253572 - Calling Array_Knob.valueAt() ignored the view argument and returned incorrect
values.
• BUG ID 271373 - A QOpenGLContext::swapBuffers() called with non-exposed window, behavior
is undefined error was occasionally printed to the command line.
• BUG ID 272541 - Linux only: Changing the root directory for cached files occasionally caused the
timeline disk cache state to become inconsistent.
• BUG ID 273650 - OCIO: Looks were not applied correctly in the timeline Viewer.
• BUG ID 280273 - Monitor Output: 10-bit monitor output signals were different from Nuke and Nuke
Studio.
• BUG ID 281553 - Linux only: Setting the OCIO environment variable did not load LUTs correctly.
• BUG ID 286434 - Soft Effects: Cloning effects occasionally caused the clone to misbehave.
• BUG ID 305193 - Frame Server: Background renders did not support container formats, such as
.mov files.
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• BUG ID 306607 - Timeline Disk Caching: Enabling or disabling See Through Missing Media in the
timeline Viewer controls did not clear the cache.
• BUG ID 308402 - Python Developers Guide: The Extending Nuke with PySide section was out-ofdate.
• BUG ID 310306 - VectorDistort: The mask_channel and premult controls did not work as expected
and have been removed.
• BUG ID 328914 - DnD: Swapping tabs did not deselect knobs.
• BUG ID 329006 - Timeline Disk Caching: Duplicating a sequence stopped the Clear Sequence
Range function working on the original sequence.
• BUG ID 329014 - Timeline Disk Caching: Clearing the cache deleted files that were in use in duplicate
sequences without warning the artist.
• BUG ID 329029 - Timeline Disk Caching: Enabling or disabling See Through Missing Media in the
timeline Viewer controls did not clear the cache.
• BUG ID 329113 - Clearing or closing large scripts occasionally caused Nuke to crash.
• BUG ID 330219 - DnD: Edit mode selection boxes were occasionally visible after actions were
completed.
• BUG ID 331325 - Node Graph: HTML tags were occasionally included in Bookmark names in the Tab
menu.
• BUG ID 332248/332276/337288/348013 - DnD: Colorwheels and user knob controls with no labels
were not marquee selectable and the highlight or placement was inconsistent.
• BUG ID 332312 - ARRIRAW: Certain colorspace options displayed Arriraw Decoder Settings errors.
• BUG ID 333372 - Timeline Disk Caching: Changing the values in a cached soft effect and then
reverting the change did not re-instate the cache.
• BUG ID 333381 - Timeline Disk Caching: Canceling a disk cache render did not list the render task as
canceled in the Timeline disk cache render panel.
• BUG ID 335607 - DnD: Colorwheel knobs with no label could be hidden by other knobs.
• BUG ID 336052 - Denoise: Rendering a script from the command line with Temporal Processing
enabled took a long time to process and included a blank first frame.
• BUG ID 336903 - Windows only: Opening a comp referencing a certain .r3d file caused Nuke Studio
to crash.
• BUG ID 337293 - DnD: Knob selection highlights did not scale with panel size adjustments.
• BUG ID 337666 - DnD: Text input knobs did not allow other knobs to be added to the same
properties line.
• BUG ID 338425 - Localization: Manually setting the localization mode to the current setting
displayed an error.
• BUG ID 338746 - Deep: Comparing DeepColorCorrect nodes using the DeepCompare node (available
from the X menu or by using Update) produced inconsistent results.
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• BUG ID 338755 - Deep: The DeepCompare node (available from the X menu or by using Update)
ignored the bounding box.
• BUG ID 338764 - Deep: The DeepCompare node (available from the X menu or by using Update) did
not work as expected with DeepCrop nodes.
• BUG ID 338777 - Deep: The DeepCompare node (available from the X menu or by using Update)
multiplier control behaved differently to the same control in the standard Compare node.
• BUG ID 339768 - Localization: Pausing localization occasionally didn't work as expected.
• BUG ID 339978 - Deep: The DeepCompare node (available from the X menu or by using Update)
occasionally produced channel mismatch errors.
• BUG ID 339987 - Deep: Viewing a DeepFromImage node's output caused Nuke to crash.
• BUG ID 340112 - Denoise: Resizing and moving the analysis box displayed CUDA errors in the
Viewer.
• BUG ID 340282 - Python: Dragging a link from a browser into Nuke did not trigger a drop event.
• BUG ID 340300/340559 - The desktop shortcuts linked to the wrong binary.
• BUG ID 340791 - Context-sensitive controls, such as those exposed when reading .exr files, failed to
copy and paste correctly when the control was driven by an expression.
• BUG ID 341283 - Project Panel: Right-clicking a source clip and selecting Clip > Reconnecting Media
caused Nuke Studio to crash.
• BUG ID 342109 - RED SDK: Loading legacy scripts into Nuke 11.2 displayed rounding errors.
• BUG ID 342324 - OCIO: Multiple createLutAndShader error messages were printed to the
command line at start-up.
• BUG ID 342580 - Deep: Disabling a DeepRead node upstream of a DeepMerge node caused Nuke to
crash.
• BUG ID 342627 - Soft Effects: Retiming .r3d clips with the TimeWarp effect displayed an error
message.
• BUG ID 342740 - RED SDK: Copying and pasting .r3d files enabled certain knobs incorrectly.
• BUG ID 342973 - Deep: Connecting a Viewer to a DeepToPoints node while rendering a script in the
Viewer caused Nuke to crash.
• BUG ID 342983 - Deep: Output from Deep scripts containing DeepRecolor nodes was not consistent
with legacy Nuke releases.
• BUG ID 343390 - Linux only: The Viewer right-click Stereo Modes > OpenGL Stereo option was
missing.
• BUG ID 343510 - Linux only: Rendering an .nk script containing .jpeg files Pythonically returned an
error.
• BUG ID 343568 - CameraTracker: Exporting distortion from CameraTracker used the
LensDistortion1 node, rather than the improved LensDistortion2 node.
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• BUG ID 343643 - Windows only: Denoise/VectorBlur nodes displayed CUDA errors in the Viewer
during normal operation.
• BUG ID 343699 - RED SDK: Several RED colorspace settings were missing from Nuke.
• BUG ID 343943 - DnD: Some text knobs could not be exposed using drag-and-drop.
• BUG ID 344083 - R3D: Project panel thumbnails were blank for certain .r3d files.
• BUG ID 344303 - Deep: DeepHoldout caused Nuke to crash in certain scripts.
• BUG ID 344552 - VectorDistort: Disabling Use GPU if available caused Nuke to crash.
• BUG ID 344947 - Windows only: Executing basicReadCallback.py caused Nuke to crash on exit.
• BUG ID 344971 - SmartVector: Connecting a Denoise node downstream of a SmartVector node
displayed an error.
• BUG ID 345702 - Linux only: Minimizing Nuke caused RAM caching to stop, even with pause
caching when the application goes to the background disabled.
• BUG ID 346215 - Hiero: Opening a project containing a large number of files displayed a Too Many
Open Files error message and caused the application to crash.
• BUG ID 346766 - Deep: Adjusting the controls in a DeepReformat node caused Nuke to crash.
• BUG ID 346935 - Write: The yuv option was missing from the file type control.
• BUG ID 347085 - Kronos: Single GPU command line renders were faster than Multi-GPU renders.
• BUG ID 347426 - Deep: Connecting Deep nodes to a ScanlineRender node and Metadata node
produced odd results.
• BUG ID 347672 - SmartVector: Rendering certain images with premult enabled created blurred
output.
• BUG ID 347745 - Python: Custom panels were limited to simple layouts.
• BUG ID 347798 - DnD: Enabling and disabling editing mode caused floating panels to resize
incorrectly.
• BUG ID 347828 - DnD: The tooltips for the drag-and-drop interface were not OS-specific.
• BUG ID 347835 - R3D: The TimeWarp soft effect altered color output in the Viewer incorrectly.
• BUG ID 347840 - Monitor Output: Video output applied colorspaces and ViewerProcesses
incorrectly, resulting in artificially dark images.
• BUG ID 348032 - Windows only: Rendering a comp that referenced a certain .r3d clip displayed
background render errors for some Gamma Curve settings.
• BUG ID 348351 - R3D: Certain .r3d files had blank color space and gamma space controls.
• BUG ID 348354 - DnD: Marquee-selecting knobs did not automatically scroll inside the Properties
panel.
• BUG ID 348552 - DnD: Pop-up widgets were occasionally hidden behind floating Properties panels.
• BUG ID 348746 - Creating a clip with an empty MediaSource() path caused Nuke to crash.
• BUG ID 348957 - DnD: Selecting a knob inside a selection of knobs did not update the selection
correctly.
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• BUG ID 349217 - DnD: Holding Ctrl/Cmd to select knobs only allowed you to drag-and-drop the
knob under the pointer.
• BUG ID 349317 - Read: Selecting an .r3d file in the file browser with the preview active and then
opening the selected file caused Nuke to crash.
• BUG ID 349457 - DnD: Resizing panels containing tables did not resize the table knob.
• BUG ID 349475 - DnD: Certain Roto knob labels were grayed-out after saving and reloading a script.
• BUG ID 349679 - R3D SDK: Reading certain 8K footage displayed a Reader did not set bounding
box error.
• BUG ID 349735 - Project Settings: The Frame Offset control extended for the entire length of the
panel.
• BUG ID 349739 - DnD: Deleting the first knob on a line shifted the remaining knobs to the line
above.
• BUG ID 349744 - DnD: Reordering the knobs on a line shifted all knobs to the line above.
• BUG ID 349746/352272 - DnD: The knob placement guide lines did not work as expected.
• BUG ID 349905 - Preferences: The color of the Edit mode button could not be changed.
• BUG ID 350166 - RED SDK: CDL files were not applied in the Nuke Viewer.
• BUG ID 350353 - RED SDK: The REDWideGamutRGB and Rec2020 colorspaces were incorrect.
• BUG ID 350393 - RED SDK: The Sharpness, Denoise, and Detail controls could not be changed in a
legacy script.
• BUG ID 350655 - RED SDK: The SimpleBlend and MagicMotion HDRx controls did not retain their
values in a legacy script.
• BUG ID 350661/350896 - RED SDK: Copying and pasting a Read node that did not use the default CC
ID from the CDL file did not work as expected.
• BUG ID 350665 - RED SDK: The MagicMotion blend bias HDRx control did not work as expected in
legacy script.
• BUG ID 350683 - RED SDK: Labels and knob names were capitalized inconsistently.
• BUG ID 350844 - DnD: The preference controlling the color for linked knobs was labeled incorrectly.
• BUG ID 350888 - RED SDK: The colorwheel controls for Lift, Gamma, and Gain did not work as
expected.
• BUG ID 350897 - DnD: The profile tab controls in the Denoise node's properties were placed on the
Denoise tab.
• BUG ID 350900 - RED SDK: Selecting certain CDL presets displayed an error.
• BUG ID 350903 - DnD: The LensDistortion node's properties incorrectly included three new, empty
groups.
• BUG ID 350907/351860 - RED SDK: Collapsing a colorwheel icon for the Lift, Gamma, and Gain
controls did not work as expected.
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• BUG ID 350915 - DnD: Using the scroll bar in the Properties panel discarded knob selections in Edit
mode.
• BUG ID 350990 - Linux only: Publishing a LiveGroup Pythonically occasionally truncated the file
name.
• BUG ID 350991 - RED SDK: Localizing a particular .r3d file rendered the clip upside down in the
Viewer.
• BUG ID 350997/352398 - RED SDK: The Look > Color Version control included v3 incorrectly.
• BUG ID 351334 - RED SDK: Right-clicking an .r3d file in the Project panel caused Nuke Studio to
crash.
• BUG ID 351585 - RED SDK: The HDRx settings did not convert Low exposure to X frame in legacy
scripts.
• BUG ID 351591 - RED SDK: Activating controls, such as Blend Bias, did not activate the knob label.
• BUG ID 351895 - RED SDK: The D.E.B control was not available for .r3d clips created using the
DRAGON sensor, or later.
• BUG ID 352383 - DnD: Dragging knobs from one tab to another in the same node Properties panel
did not work as expected.
• BUG ID 352399 - RED SDK: Reading files written with IPP2 support did not convert them to Nuke's
legacy color pipeline and displayed an error.
• BUG ID 352403 - RED SDK: Clicking Load Settings from RMD multiple times caused Nuke to crash.
• BUG ID 352406/352989 - RED SDK: Clicking Load Settings from RMD did not always display an error
message if the .r3d was written with IPP2 support.
• BUG ID 352423 - RED SDK: Zooming and changing control values caused the Viewer cache to behave
erratically.
• BUG ID 352432 - Project Panel: Clicking the color picker button in the Project panel turned clip
shading on, even when it was disabled in the Preferences.
• BUG ID 352474 - RED SDK: Changing the Color Version to v1 in an .r3d file's Properties caused
Nuke to crash.
• BUG ID 352477 - RED SDK: Certain Read node thumbnails in legacy scripts displayed a
ReaderMessageUnknown error.
• BUG ID 352564 - RED SDK: Adjusting the Gamma Curve control caused Nuke Studio to crash.
• BUG ID 352710 - RED SDK: Importing certain mov64 clips displayed an error in the Viewer and
created black shots on the timeline.
• BUG ID 352725/352746 - RED SDK: Right-clicking in an .r3d file's Properties panel and selecting Set
knobs to default or Set Key on all knobs caused Nuke Studio to crash.
• BUG ID 352902 - DnD: The CameraTracker node's Properties panel was rearranged incorrectly.
• BUG ID 352939 - Project Panel: Exporting a sequence or clip or using the color picker reset the
sorting mode in the Project panel.
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• BUG ID 353051 - RED SDK: Certain Gamma Curve settings displayed an invalid LUT error in the
Viewer.
• BUG ID 353071 - DeepRecolor: Enabling target input alpha did not process AOV passes through the
color input.
• BUG ID 353210 - RED SDK: The HDR Mode and Decode Resolution controls did not work as
expected when used together and occasionally caused Nuke to crash.
• BUG ID 353237/353253 - RED SDK: Setting the Gamma Curve to Half Float Linear did not disable
unnecessary controls in the Properties panel.
• BUG ID 353248 - Windows only: The EULA in the installer was not formatted correctly.
• BUG ID 353310 - Localization: Certain .r3d files were not localized as expected when Localization
Policy was set to On Demand in the clip's Read Properties panel.
• BUG ID 353405 - DnD: Marquee selecting knobs and then dragging the selection did not work as
expected.
• BUG ID 353660 - Create Comp: Undoing a Create Comp operation and then executing Create Comp
again caused Nuke Studio to crash.
• BUG ID 353670 - ARRIRAW: The color space and color processing controls did not work as
expected when used together and displayed an error in the Viewer.
• BUG ID 353693 - Windows only: Nuke could not read .mxf files from the Alexa Mini.
• BUG ID 353838 - RED SDK: Create Comp and Export operations produced different output for files
containing HDRx X-Frame blend information.
• BUG ID 353895 - RED SDK: The tooltip for the HDRx > Blend Bias control was out-of-date.
• BUG ID 353903 - RED SDK: The tooltip for the Look > Contrast control was out-of-date.
• BUG ID 353910 - RED SDK: The Look > RGB control had incorrect range parameters.
• BUG ID 353911 - RED SDK: The Gamma and Gain control had incorrect range parameters.
• BUG ID 353952 - RED SDK: HDRx X-Frame blend information was not applied to exported files from
the Frame Server.
• BUG ID 353981 - RED SDK: Cloning a Read node referencing an .r3d file and then changing a control
caused Nuke to crash.
• BUG ID 354159 - DnD: The unnamed channel matrix in ShuffleCopy nodes was selectable, even
though it was not applicable in DnD edit mode.
• BUG ID 354251 - RED SDK: The Gamma Curve tooltip did not specify all the controls that are
disabled when Half Float Linear is selected.
• BUG ID 354398 - VectorGenerator: Enabling Flicker Compensation altered the motion vectors
produced.
• BUG ID 354515 - RED SDK: The Look > DRX control did not work as expected for certain nonDRAGON sensor .r3d files.
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• BUG ID 354531 - Project Load: Loading a project from a different operating system that referenced
.r3d files caused Nuke Studio to become unresponsive.
• BUG ID 354537 - DnD: Dropping a knob on the Node tab in the Project Settings caused Nuke to
crash.
• BUG ID 354900 - DeepHoldout: Connecting a Viewer to a DeepHoldOut node with only the main
input connected caused Nuke to crash.
• BUG ID 355069 - Alexa LF Open Gate Material (4448 x 3096): UHD-1 was missing from the resolution
dropdown.
• BUG ID 355070 - Alexa LF Open Gate Material (4448 x 3096) - Selecting an aspect ratio other than
1.0 limited the available resolution options incorrectly.
• BUG ID 355116 - Alexa LF UHD-1 material (3840 x 2160) - Selecting an aspect ratio other than 1.0
limited the available resolution options incorrectly.
• BUG ID 355121 - Alexa material (2880 x 1620) 16by9: 1.25 lens squeeze could not be selected.
• BUG ID 355138/355139/355143/355144 - Alexa 4:3 (2880 x 2160) - 4by3: It was not possible to select
1.25/1.3/1.33/1.5 lens squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355146/355147/355149/355150 - Alexa "Clean Open Gate" (3414 x 2198): It was not possible
to select 1.25/1.3/1.33/1.5 lens squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355151 - Alexa "Clean Open Gate" (3414 x 2198): Support for 1.55 aspect ratio with 2.0 lens
squeeze was unavailable
• BUG ID 355152/355153 - SXT/Mini "Open Gate" (3424 x 2202): It was not possible to select 1.33/1.5
lens squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355154/355155/355156 - 6:5 Alexa SXT (2578 x 2160): It was not possible to select 1.33/1.5/2.0
lens squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355157/355158 - 16:9 3.2K Alexa SXT (3168 x 1782): It was not possible to select 1.33/1.5 lens
squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355259 - ARRIRAW: The mxfReader failed to decompress large .mxf files.
• BUG ID 355294 - RED SDK: The tooltips for the Shadow, Saturation, Contrast, Brightness, and
RGB controls contained incorrect information.
• BUG ID 355421 - ARRIRAW: ARRI - ALEXA_LF_Sensor footage displayed an error in the Viewer.
• BUG ID 355544 - ARRIRAW: Loading a legacy .hrox project containing certain .r3d files caused Nuke
to crash.
• BUG ID 355717 - Calling getLinkedKnob() incorrectly on an a unlinked Knob caused Nuke to crash.
• BUG ID 355812 - ARRIRAW: Loading legacy scripts did not load knob settings from the project file.
• BUG ID 356167 - ARRIRAW: Opening a legacy script containing unsupported ARRI footage caused
Nuke to crash.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/111/ndkdevguide/appendixc/index.html for more
information.
As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.
Release Type

Example

Compatibility

Version

10.0v1 to 10.0v2

API and ABI

Point

10.0v1 to 10.5v1

API

Major

10.0v1 to 11.0v1

-

Recompile

Rewrite

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.
As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features
There are no new features in this release.
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Feature Enhancements
• BUG ID 197003 - Localization: You can now query a Read node's localization state using Python API
calls. See File Localization API Extension for more information.

Bug Fixes
• BUG ID 348068 - Python: The onDestroy() callback was called twice on exit.
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Release Date
17 July 2018

Qualified Operating Systems
• macOS Sierra (10.12) or macOS High Sierra (10.13)
• Windows 7 or Windows 10 (64-bit)
• CentOS 6 or CentOS 7 (64-bit)
Other operating systems may work, but have not been fully tested.

Requirements for Nuke's GPU Acceleration
If you want to enable Nuke to calculate certain nodes using the GPU, there are some additional
requirements.

NVIDIA
An NVIDIA GPU with compute capability 2.0 (Fermi) or above. A list of the compute capabilities of
NVIDIA GPUs is available at www.nvidia.co.uk/object/cuda_gpus_uk.html.
NOTE: The compute capability is a property of the GPU hardware and can't be altered by a
software update.
With graphics drivers capable of running CUDA 8.0 & 6.5 or above.
• On Windows and Linux, CUDA graphics drivers are bundled with the regular drivers for your NVIDIA
GPU. Driver version r361 or above is required.
Go to http://www.nvidia.com/Download/Find.aspx?lang=en-us for more information.
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• On Mac, the CUDA driver is separate from the NVIDIA graphics driver and must be installed, if you
don't have it already. The minimum requirement is driver version r361 which can be downloaded
from www.nvidia.com/drivers.
NOTE: We recommend using the latest graphics drivers, where possible, regardless of
operating system.

AMD
• On Windows and Linux, an AMD GPU and driver from the following list:
Windows GPU

Driver

Linux GPU

Driver

AMD FirePro W8100

17.Q2.1

AMD FirePro W8100

17.Q2.1

AMD FirePro W9100

17.Q2.1

AMD FirePro W9100

17.Q2.1

AMD Radeon R9 Fury X

17.4.3 - 17.6.2 AMD Radeon R9 Fury X

17.10

AMD Radeon RX 480

17.Q2.1

17.Q2.1

AMD Radeon RX 480

AMD Radeon Pro WX 7100 17.4.3 - 17.6.2 AMD Radeon Pro WX 7100 17.10

NOTE: Other AMD GPUs may work, but have not been fully tested.
• On Mac an AMD FirePro GPU on late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and late 2016
MacBook Pro 13,3, running OS X 10.9.3 'Mavericks', or later.

Mac GPUs
Nuke supports GPU-enabled nodes on the late 2013 Mac Pro 6,1, mid 2015 MacBook Pro 11,5, and
late 2016 MacBook Pro 13,3, (running OS X 10.9.3 'Mavericks', or later), including a new Enable multiGPU support option. When enabled in the preferences, GPU processing is shared between the
available GPUs for extra processing speed.
NOTE: To ensure you get the best performance from OpenCL GPUs, we recommend
updating Mavericks to 10.9.5, or above for full functionality. However:
• If you're running an earlier version of Mac OS X than 10.9.5 and processing images greater
than 4 mega pixels resolution, VectorGenerator, Kronos, and MotionBlur do not support
GPU acceleration.
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• If you're running an earlier version of Mac OS X than 10.9.4, Kronos and MotionBlur do not
support GPU acceleration.

New Features
Improved Tab Menu
The Node Graph's tab menu has been improved, including a new search algorithm, allowing you to
search for and add nodes more easily using partial names. Commonly used nodes are weighted so
that they appear higher up the list of choices and you can also favorite nodes, pinning them to the
top of the list with the star icon. Weights and favorites can be enabled, disabled and cleared in
Preferences > Behaviors > Nodes. The J Bookmarked nodes menu also supports the updated
search functionality.

New Interface for User Knob Creation
Also known as Drag-and-drop knobs (DnD), this update significantly reduces the time spent exposing
user knobs and adding custom knobs to node properties panels within Nuke. As a result, you can
create and modify gizmos and Live Groups more easily, stream-lining collaborative workflows.
Instead of right-clicking and selecting Manage User Knobs, simply click the edit button at the top of
the Properties panel to get started. You can drag-and-drop knobs between open node panels or add
your own using the knob icons listed at the top of the panel. You can also order, hide, customize, and
delete knobs within the Properties panel. If you work with floating panels, you can float the User
Knob Editor too. Click the edit button again to finish customization.

Nuke Studio Project Panel Improvements
These are a number of enhancements to the way you can organize, manage and, navigate through
your projects in Nuke Studio. These enhancements also apply to the spreadsheet and the timeline.
• New Sorting - a new way to arrange your project bin alphabetically or by custom order. This is
accessible through the new buttons at the top of the Project panel and it has controls for the
hierarchy view and on the bin view independently.
• Improved Searching - improved search functionality on the Project panel and on the spreadsheet
with new options to search all metadata or not, and to use all or any of the input string.
• Poster Frame - a new poster frame functionality allows you to set the poster frame for your source
clips and shots. You can set it for single or multiple source clips using absolute or relative frames,
which is useful when you have shots with slates or black handles.
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• Color Assignments - you can now assign colors to your source clips, shots, and spreadsheet events.
You can also set colors based on file types.

Smart Vector Toolset Improvements
The Smart Vector Toolset in NukeX has several improvements that speed up the generation of vectors
and extend the use cases where the toolset can be used.
• GPU Acceleration - the SmartVector and VectorDistort nodes have been rewritten to make the best
use of the GPU, dramatically reducing the time it takes to both create the smart motion vectors and
use them to warp images.
• Mask Input to SmartVector - you can now supply a mask to the SmartVector node to specify
regions containing unwanted objects or motion to help with handling occlusions and image
boundaries.
• Background Vector Rendering - you can now render vectors in the background using the Export
Write button.

File Localization API Extension
Building on the updates to the localization system in Nuke 11.1, the system has been further
extended to provide greater control over customization through new callbacks. We have also added a
new environment variable, NUKE_LOCALIZATION_NUMWATCHERS, to improve performance when
checking the validity of localized files, especially when working with scripts with a high number of
Read nodes or a high number of frames.

Additional Python callbacks:
The following Python callbacks have been added, giving further control over files and Read nodes as
they are added to the queue to be localized and transition between being out-of-date and localized.

Callback functions executed on each file’s localization event:
• localization.FileEvent.ADDED
• localization.FileEvent.REMOVED
• localization.FileEvent.OUT_OF_DATE
• localization.FileEvent.CACHE_FULL
• localization.FileEvent.DISK_FULL
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Callback functions executed on each Read nodes localization event:
• localization.ReadStatus.NOT_LOCALIZED
• localization.ReadStatus.LOCALIZING
• localization.ReadStatus.PARTIALLY_LOCALIZED
• localization.ReadStatus.LOCALIZED
• localization.ReadStatus.OUT_OF_DATE
• localization.ReadStatus.LOCALIZATION_DISABLED

Auto switch from localized to network files:
A new preference, read source files when localized files are out of date, has been added. When
enabled, Nuke checks the localized files against the source files and switches to their source files if
the local files become out of date.

Control over the number of simultaneous file checks:
A new environment variable NUKE_LOCALIZATION_NUMWATCHERS controls the number of
simultaneous file checks, improving performance when working with large scripts over a high
capacity network. We have found that checking the status or force-updating a large number of reads
or large sequences could create a bottleneck as Nuke evaluated the files. To improve this we have
added an option to increase the number of file checks that can occur at once to expedite this process
with an appropriate network configuration.

ARRI SDK Update
ARRIRAW has been updated to version 5.4.3.5, adding the following features:
• Alexa LF formats and color tables
• Rec2100/PQ and Rec2100/HLG HDR colorspaces
• Extended white balance CC values from -16 to +16
The full ARRI SDK release notes are publicly available from:
http://www.arri.com/support/downloads/searchable_downloads/

R3D SDK Update
R3D SDK has been updated to version 7.0.6, adding the following features:
• R3D Weapon Monstro 8K VV and Helium 8K S35 Sensors
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• ImageColorDCIP3, ImageColorProPhotoRGB, ImageColorDCIP3D65 colorspaces
• ImageGammaHybridLogGamma, ImageGamma2_2, ImageGamma2_6 Gamma Curves
NOTE: Support for IPP2 will be available in a future release.
The full R3D SDK release notes are publicly available in the SDK download from:
https://www.red.com/developers/

New Deep Compositing API
Nuke has a new API for Deep Compositing, which manages memory more efficiently resulting in
improved performance for some nodes. Nuke’s native deep compositing nodes have been converted
to this new API and in our tests, scripts are processed up to 1.6x faster compared to Nuke 11.1.
Performance improvements vary by node and set up; for example, DeepRecolor and DeepTransform
show the best gains, while DeepColorCorrect has little improvement.
To take advantage of these performance improvements, custom deep nodes need to be converted to
the new API. Existing custom nodes still work in Nuke 11.2, defaulting to the pre-existing API, but will
not have any improvement to performance.
Details on the API changes and converting custom nodes are available in the NDK Developer Guide.

Deep Compositing Improvements
In addition to the new API, Nuke 11.2v1 includes a number bug fixes and improvements to the deep
compositing tools including the DeepExpression node having functional parity with Nuke’s standard
Expression node.
Workflows using metadata have also been added to Nuke’s Deep nodes. Metadata nodes
(ModifyMetadata, ViewMetadata, CopyMetadata, and so on) can now be used in a tree with Deep
nodes.
The DeepMerge node has been updated to allow you to use metadata from either the A input, the B
input, or both.
NOTE: 2D nodes should not be inserted in between Metadata nodes within a deep stream.
The Viewer must be connected to a Deep node rather than a Metadata node in order to view
the output of deep streams.
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Feature Enhancements
• BUG ID 134441 - Deep: The functionality of the DeepExpression node has been expanded to match
the standard Expression node.
• BUG ID 139582 - Deep: The Preferences dialog now includes a control to choose the connector
color between Deep nodes under Panels > Node Graph > Arrow.
• BUG ID 151165 - DeepWrite: Only Zip1 compression is supported for .exr output. The other options
have been removed.
• BUG ID 158323 - Deep: A new control, target input alpha, has been added to the DeepRecolor
node. When enabled, the color input’s alpha is distributed among the samples so that the final
resulting alpha after flattening of the deep data matches the color input’s alpha.
• BUG ID 163251 - Deep: The nodes listed under MetaData in the nodes toolbar now work in Deep
node trees.
• BUG ID 196909/196912/196941/197559 - SmartVector: Render progress bars and error reporting has
been improved.
• BUG ID 196839 - Deep: A new deep option has been added to the DeepRecolor node's set bbox to
control, allowing you manage bounding boxes between deep and standard nodes.
• BUG ID 219397 - SmartVector: A new control, Flicker Compensation, has been added to the
Properties panel. When enabled, SmartVector compensates for luminance changes in the source
image when calculating vectors.
• BUG ID 278255 - Localization: You can now use Cache > Localization > Force Update > Selected
on nodes when Localization is paused.
• BUG ID 333431 - Mac OS X/macOS only: Nuke now supports AMD Radeon Vega GPUs.
• BUG ID 345759 OCIO: The Log3G10 LUT has been added to Nuke's standard LUTs list.

Bug Fixes
• BUG ID 136654 - R3D: Certain single frame .r3d files beginning on frame 0 were interpreted
incorrectly as starting on frame 1.
• BUG ID 142813 - Deep: Executing a script in terminal mode that read in a Deep image then wrote it
to disk caused Nuke to crash.
• BUG ID 145272 - Node Graph: The Tab menu included a @;&<node>Branch entry incorrectly.
• BUG ID 145308 - DeepSample: Particles employing sprites caused the deep.front and deep.back
channels to display Inf values in a customer script.
• BUG ID 148823 - Nuke Assist: Nuke scripts containing Keylight or FurnaceCore nodes checked out a
nuke_i license.
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• BUG ID 150961 - Deep: It was possible to connect Framehold nodes to Deep nodes, even though
they did not function.
• BUG ID 154977 - Deep: The DeepColorCorrect node culled samples incorrectly.
• BUG ID 161956 - Deep: The DeepExpression node did not clamp output in the same way as the
standard Expression node.
• BUG ID 161979/328288 - Deep: The DeepRead node set the width and height controls to 1 under
the correct value.
• BUG ID 168261 - Deep: Copying and pasting DeepExpression nodes discarded control values.
• BUG ID 174062 - Documentation: It was not clear in the documentation that Nuke scales non-HD
DNxHD output to 1080p.
• BUG ID 196487 - Documentation: The port range of local Frame Server processes was missing from
the documentation.
• BUG ID 196940 - ARRIRAW: The uuid metadata for media.arri.camera displayed incorrectly.
• BUG ID 201586 - Mac OS X/macOS: The Restore Snapshot function did not work as expected.
• BUG ID 202223 - Deep: DeepWrite nodes included several unusable EXR compression options.
• BUG ID 221568 - Deep: Enabling specify z in the DeepFromImage Properties panel caused
DeepWrite nodes to output corrupt data.
• BUG ID 251544 - Monitor Output: Switching from Active to A/B mode with Full Resolution Stereo
selected caused the monitor to display multiple images incorrectly.
• BUG ID 253572 - Calling Array_Knob.valueAt() ignored the view argument and returned incorrect
values.
• BUG ID 271373 - A QOpenGLContext::swapBuffers() called with non-exposed window, behavior
is undefined error was occasionally printed to the command line.
• BUG ID 272541 - Linux only: Changing the root directory for cached files occasionally caused the
timeline disk cache state to become inconsistent.
• BUG ID 273650 - OCIO: Looks were not applied correctly in the timeline Viewer.
• BUG ID 280273 - Monitor Output: 10-bit monitor output signals were different from Nuke and Nuke
Studio.
• BUG ID 281553 - Linux only: Setting the OCIO environment variable did not load LUTs correctly.
• BUG ID 286434 - Soft Effects: Cloning effects occasionally caused the clone to misbehave.
• BUG ID 305193 - Frame Server: Background renders did not support container formats, such as
.mov files.
• BUG ID 306607 - Timeline Disk Caching: Enabling or disabling See Through Missing Media in the
timeline Viewer controls did not clear the cache.
• BUG ID 308402 - Python Developers Guide: The Extending Nuke with PySide section was out-ofdate.
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• BUG ID 310306 - VectorDistort: The mask_channel and premult controls did not work as expected
and have been removed.
• BUG ID 328914 - DnD: Swapping tabs did not deselect knobs.
• BUG ID 329006 - Timeline Disk Caching: Duplicating a sequence stopped the Clear Sequence
Range function working on the original sequence.
• BUG ID 329014 - Timeline Disk Caching: Clearing the cache deleted files that were in use in duplicate
sequences without warning the artist.
• BUG ID 329029 - Timeline Disk Caching: Enabling or disabling See Through Missing Media in the
timeline Viewer controls did not clear the cache.
• BUG ID 329113 - Clearing or closing large scripts occasionally caused Nuke to crash.
• BUG ID 330219 - DnD: Edit mode selection boxes were occasionally visible after actions were
completed.
• BUG ID 331325 - Node Graph: HTML tags were occasionally included in Bookmark names in the Tab
menu.
• BUG ID 332248/332276/337288/348013 - DnD: Colorwheels and user knob controls with no labels
were not marquee selectable and the highlight or placement was inconsistent.
• BUG ID 332312 - ARRIRAW: Certain colorspace options displayed Arriraw Decoder Settings errors.
• BUG ID 333372 - Timeline Disk Caching: Changing the values in a cached soft effect and then
reverting the change did not re-instate the cache.
• BUG ID 333381 - Timeline Disk Caching: Canceling a disk cache render did not list the render task as
canceled in the Timeline disk cache render panel.
• BUG ID 335607 - DnD: Colorwheel knobs with no label could be hidden by other knobs.
• BUG ID 336052 - Denoise: Rendering a script from the command line with Temporal Processing
enabled took a long time to process and included a blank first frame.
• BUG ID 336903 - Windows only: Opening a comp referencing a certain .r3d file caused Nuke Studio
to crash.
• BUG ID 337293 - DnD: Knob selection highlights did not scale with panel size adjustments.
• BUG ID 337666 - DnD: Text input knobs did not allow other knobs to be added to the same
properties line.
• BUG ID 338425 - Localization: Manually setting the localization mode to the current setting
displayed an error.
• BUG ID 338746 - Deep: Comparing DeepColorCorrect nodes using the DeepCompare node (available
from the X menu or by using Update) produced inconsistent results.
• BUG ID 338755 - Deep: The DeepCompare node (available from the X menu or by using Update)
ignored the bounding box.
• BUG ID 338764 - Deep: The DeepCompare node (available from the X menu or by using Update) did
not work as expected with DeepCrop nodes.

RELEASE NOTES
58

Release Notes for Nuke and Hiero 11.2v1 | Bug Fixes

• BUG ID 338777 - Deep: The DeepCompare node (available from the X menu or by using Update)
multiplier control behaved differently to the same control in the standard Compare node.
• BUG ID 339768 - Localization: Pausing localization occasionally didn't work as expected.
• BUG ID 339978 - Deep: The DeepCompare node (available from the X menu or by using Update)
occasionally produced channel mismatch errors.
• BUG ID 339987 - Deep: Viewing a DeepFromImage node's output caused Nuke to crash.
• BUG ID 340112 - Denoise: Resizing and moving the analysis box displayed CUDA errors in the
Viewer.
• BUG ID 340282 - Python: Dragging a link from a browser into Nuke did not trigger a drop event.
• BUG ID 340300/340559 - The desktop shortcuts linked to the wrong binary.
• BUG ID 340791 - Context-sensitive controls, such as those exposed when reading .exr files, failed to
copy and paste correctly when the control was driven by an expression.
• BUG ID 341283 - Project Panel: Right-clicking a source clip and selecting Clip > Reconnecting Media
caused Nuke Studio to crash.
• BUG ID 342109 - RED SDK: Loading legacy scripts into Nuke 11.2 displayed rounding errors.
• BUG ID 342324 - OCIO: Multiple createLutAndShader error messages were printed to the
command line at start-up.
• BUG ID 342580 - Deep: Disabling a DeepRead node upstream of a DeepMerge node caused Nuke to
crash.
• BUG ID 342627 - Soft Effects: Retiming .r3d clips with the TimeWarp effect displayed an error
message.
• BUG ID 342740 - RED SDK: Copying and pasting .r3d files enabled certain knobs incorrectly.
• BUG ID 342973 - Deep: Connecting a Viewer to a DeepToPoints node while rendering a script in the
Viewer caused Nuke to crash.
• BUG ID 342983 - Deep: Output from Deep scripts containing DeepRecolor nodes was not consistent
with legacy Nuke releases.
• BUG ID 343390 - Linux only: The Viewer right-click Stereo Modes > OpenGL Stereo option was
missing.
• BUG ID 343510 - Linux only: Rendering an .nk script containing .jpeg files Pythonically returned an
error.
• BUG ID 343568 - CameraTracker: Exporting distortion from CameraTracker used the
LensDistortion1 node, rather than the improved LensDistortion2 node.
• BUG ID 343643 - Windows only: Denoise/VectorBlur nodes displayed CUDA errors in the Viewer
during normal operation.
• BUG ID 343699 - RED SDK: Several RED colorspace settings were missing from Nuke.
• BUG ID 343943 - DnD: Some text knobs could not be exposed using drag-and-drop.
• BUG ID 344083 - R3D: Project panel thumbnails were blank for certain .r3d files.
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• BUG ID 344303 - Deep: DeepHoldout caused Nuke to crash in certain scripts.
• BUG ID 344552 - VectorDistort: Disabling Use GPU if available caused Nuke to crash.
• BUG ID 344947 - Windows only: Executing basicReadCallback.py caused Nuke to crash on exit.
• BUG ID 344971 - SmartVector: Connecting a Denoise node downstream of a SmartVector node
displayed an error.
• BUG ID 345702 - Linux only: Minimizing Nuke caused RAM caching to stop, even with pause
caching when the application goes to the background disabled.
• BUG ID 346215 - Hiero: Opening a project containing a large number of files displayed a Too Many
Open Files error message and caused the application to crash.
• BUG ID 346766 - Deep: Adjusting the controls in a DeepReformat node caused Nuke to crash.
• BUG ID 346935 - Write: The yuv option was missing from the file type control.
• BUG ID 347085 - Kronos: Single GPU command line renders were faster than Multi-GPU renders.
• BUG ID 347426 - Deep: Connecting Deep nodes to a ScanlineRender node and Metadata node
produced odd results.
• BUG ID 347672 - SmartVector: Rendering certain images with premult enabled created blurred
output.
• BUG ID 347745 - Python: Custom panels were limited to simple layouts.
• BUG ID 347798 - DnD: Enabling and disabling editing mode caused floating panels to resize
incorrectly.
• BUG ID 347828 - DnD: The tooltips for the drag-and-drop interface were not OS-specific.
• BUG ID 347835 - R3D: The TimeWarp soft effect altered color output in the Viewer incorrectly.
• BUG ID 347840 - Monitor Output: Video output applied colorspaces and ViewerProcesses
incorrectly, resulting in artificially dark images.
• BUG ID 348032 - Windows only: Rendering a comp that referenced a certain .r3d clip displayed
background render errors for some Gamma Curve settings.
• BUG ID 348351 - R3D: Certain .r3d files had blank color space and gamma space controls.
• BUG ID 348354 - DnD: Marquee-selecting knobs did not automatically scroll inside the Properties
panel.
• BUG ID 348552 - DnD: Pop-up widgets were occasionally hidden behind floating Properties panels.
• BUG ID 348746 - Creating a clip with an empty MediaSource() path caused Nuke to crash.
• BUG ID 348957 - DnD: Selecting a knob inside a selection of knobs did not update the selection
correctly.
• BUG ID 349217 - DnD: Holding Ctrl/Cmd to select knobs only allowed you to drag-and-drop the
knob under the pointer.
• BUG ID 349317 - Read: Selecting an .r3d file in the file browser with the preview active and then
opening the selected file caused Nuke to crash.
• BUG ID 349457 - DnD: Resizing panels containing tables did not resize the table knob.
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• BUG ID 349475 - DnD: Certain Roto knob labels were grayed-out after saving and reloading a script.
• BUG ID 349679 - R3D SDK: Reading certain 8K footage displayed a Reader did not set bounding
box error.
• BUG ID 349735 - Project Settings: The Frame Offset control extended for the entire length of the
panel.
• BUG ID 349739 - DnD: Deleting the first knob on a line shifted the remaining knobs to the line
above.
• BUG ID 349744 - DnD: Reordering the knobs on a line shifted all knobs to the line above.
• BUG ID 349746/352272 - DnD: The knob placement guide lines did not work as expected.
• BUG ID 349905 - Preferences: The color of the Edit mode button could not be changed.
• BUG ID 350166 - RED SDK: CDL files were not applied in the Nuke Viewer.
• BUG ID 350353 - RED SDK: The REDWideGamutRGB and Rec2020 colorspaces were incorrect.
• BUG ID 350393 - RED SDK: The Sharpness, Denoise, and Detail controls could not be changed in a
legacy script.
• BUG ID 350655 - RED SDK: The SimpleBlend and MagicMotion HDRx controls did not retain their
values in a legacy script.
• BUG ID 350661/350896 - RED SDK: Copying and pasting a Read node that did not use the default CC
ID from the CDL file did not work as expected.
• BUG ID 350665 - RED SDK: The MagicMotion blend bias HDRx control did not work as expected in
legacy script.
• BUG ID 350683 - RED SDK: Labels and knob names were capitalized inconsistently.
• BUG ID 350844 - DnD: The preference controlling the color for linked knobs was labeled incorrectly.
• BUG ID 350888 - RED SDK: The colorwheel controls for Lift, Gamma, and Gain did not work as
expected.
• BUG ID 350897 - DnD: The profile tab controls in the Denoise node's properties were placed on the
Denoise tab.
• BUG ID 350900 - RED SDK: Selecting certain CDL presets displayed an error.
• BUG ID 350903 - DnD: The LensDistortion node's properties incorrectly included three new, empty
groups.
• BUG ID 350907/351860 - RED SDK: Collapsing a colorwheel icon for the Lift, Gamma, and Gain
controls did not work as expected.
• BUG ID 350915 - DnD: Using the scroll bar in the Properties panel discarded knob selections in Edit
mode.
• BUG ID 350990 - Linux only: Publishing a LiveGroup Pythonically occasionally truncated the file
name.
• BUG ID 350991 - RED SDK: Localizing a particular .r3d file rendered the clip upside down in the
Viewer.

RELEASE NOTES
61

Release Notes for Nuke and Hiero 11.2v1 | Bug Fixes

• BUG ID 350997/352398 - RED SDK: The Look > Color Version control included v3 incorrectly.
• BUG ID 351334 - RED SDK: Right-clicking an .r3d file in the Project panel caused Nuke Studio to
crash.
• BUG ID 351585 - RED SDK: The HDRx settings did not convert Low exposure to X frame in legacy
scripts.
• BUG ID 351591 - RED SDK: Activating controls, such as Blend Bias, did not activate the knob label.
• BUG ID 351895 - RED SDK: The D.E.B control was not available for .r3d clips created using the
DRAGON sensor, or later.
• BUG ID 352383 - DnD: Dragging knobs from one tab to another in the same node Properties panel
did not work as expected.
• BUG ID 352399 - RED SDK: Reading files written with IPP2 support did not convert them to Nuke's
legacy color pipeline and displayed an error.
• BUG ID 352403 - RED SDK: Clicking Load Settings from RMD multiple times caused Nuke to crash.
• BUG ID 352406/352989 - RED SDK: Clicking Load Settings from RMD did not always display an error
message if the .r3d was written with IPP2 support.
• BUG ID 352423 - RED SDK: Zooming and changing control values caused the Viewer cache to behave
erratically.
• BUG ID 352432 - Project Panel: Clicking the color picker button in the Project panel turned clip
shading on, even when it was disabled in the Preferences.
• BUG ID 352474 - RED SDK: Changing the Color Version to v1 in an .r3d file's Properties caused
Nuke to crash.
• BUG ID 352477 - RED SDK: Certain Read node thumbnails in legacy scripts displayed a
ReaderMessageUnknown error.
• BUG ID 352564 - RED SDK: Adjusting the Gamma Curve control caused Nuke Studio to crash.
• BUG ID 352710 - RED SDK: Importing certain mov64 clips displayed an error in the Viewer and
created black shots on the timeline.
• BUG ID 352725/352746 - RED SDK: Right-clicking in an .r3d file's Properties panel and selecting Set
knobs to default or Set Key on all knobs caused Nuke Studio to crash.
• BUG ID 352902 - DnD: The CameraTracker node's Properties panel was rearranged incorrectly.
• BUG ID 352939 - Project Panel: Exporting a sequence or clip or using the color picker reset the
sorting mode in the Project panel.
• BUG ID 353051 - RED SDK: Certain Gamma Curve settings displayed an invalid LUT error in the
Viewer.
• BUG ID 353071 - DeepRecolor: Enabling target input alpha did not process AOV passes through the
color input.
• BUG ID 353210 - RED SDK: The HDR Mode and Decode Resolution controls did not work as
expected when used together and occasionally caused Nuke to crash.
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• BUG ID 353237/353253 - RED SDK: Setting the Gamma Curve to Half Float Linear did not disable
unnecessary controls in the Properties panel.
• BUG ID 353248 - Windows only: The EULA in the installer was not formatted correctly.
• BUG ID 353310 - Localization: Certain .r3d files were not localized as expected when Localization
Policy was set to On Demand in the clip's Read Properties panel.
• BUG ID 353405 - DnD: Marquee selecting knobs and then dragging the selection did not work as
expected.
• BUG ID 353660 - Create Comp: Undoing a Create Comp operation and then executing Create Comp
again caused Nuke Studio to crash.
• BUG ID 353670 - ARRIRAW: The color space and color processing controls did not work as
expected when used together and displayed an error in the Viewer.
• BUG ID 353693 - Windows only: Nuke could not read .mxf files from the Alexa Mini.
• BUG ID 353838 - RED SDK: Create Comp and Export operations produced different output for files
containing HDRx X-Frame blend information.
• BUG ID 353895 - RED SDK: The tooltip for the HDRx > Blend Bias control was out-of-date.
• BUG ID 353903 - RED SDK: The tooltip for the Look > Contrast control was out-of-date.
• BUG ID 353910 - RED SDK: The Look > RGB control had incorrect range parameters.
• BUG ID 353911 - RED SDK: The Gamma and Gain control had incorrect range parameters.
• BUG ID 353952 - RED SDK: HDRx X-Frame blend information was not applied to exported files from
the Frame Server.
• BUG ID 353981 - RED SDK: Cloning a Read node referencing an .r3d file and then changing a control
caused Nuke to crash.
• BUG ID 354159 - DnD: The unnamed channel matrix in ShuffleCopy nodes was selectable, even
though it was not applicable in DnD edit mode.
• BUG ID 354251 - RED SDK: The Gamma Curve tooltip did not specify all the controls that are
disabled when Half Float Linear is selected.
• BUG ID 354398 - VectorGenerator: Enabling Flicker Compensation altered the motion vectors
produced.
• BUG ID 354515 - RED SDK: The Look > DRX control did not work as expected for certain nonDRAGON sensor .r3d files.
• BUG ID 354531 - Project Load: Loading a project from a different operating system that referenced
.r3d files caused Nuke Studio to become unresponsive.
• BUG ID 354537 - DnD: Dropping a knob on the Node tab in the Project Settings caused Nuke to
crash.
• BUG ID 354900 - DeepHoldout: Connecting a Viewer to a DeepHoldOut node with only the main
input connected caused Nuke to crash.
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• BUG ID 355069 - Alexa LF Open Gate Material (4448 x 3096): UHD-1 was missing from the resolution
dropdown.
• BUG ID 355070 - Alexa LF Open Gate Material (4448 x 3096) - Selecting an aspect ratio other than
1.0 limited the available resolution options incorrectly.
• BUG ID 355116 - Alexa LF UHD-1 material (3840 x 2160) - Selecting an aspect ratio other than 1.0
limited the available resolution options incorrectly.
• BUG ID 355121 - Alexa material (2880 x 1620) 16by9: 1.25 lens squeeze could not be selected.
• BUG ID 355138/355139/355143/355144 - Alexa 4:3 (2880 x 2160) - 4by3: It was not possible to select
1.25/1.3/1.33/1.5 lens squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355146/355147/355149/355150 - Alexa "Clean Open Gate" (3414 x 2198): It was not possible
to select 1.25/1.3/1.33/1.5 lens squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355151 - Alexa "Clean Open Gate" (3414 x 2198): Support for 1.55 aspect ratio with 2.0 lens
squeeze was unavailable
• BUG ID 355152/355153 - SXT/Mini "Open Gate" (3424 x 2202): It was not possible to select 1.33/1.5
lens squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355154/355155/355156 - 6:5 Alexa SXT (2578 x 2160): It was not possible to select 1.33/1.5/2.0
lens squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355157/355158 - 16:9 3.2K Alexa SXT (3168 x 1782): It was not possible to select 1.33/1.5 lens
squeeze when unsqueeze anamorphic was enabled.
• BUG ID 355259 - ARRIRAW: The mxfReader failed to decompress large .mxf files.
• BUG ID 355294 - RED SDK: The tooltips for the Shadow, Saturation, Contrast, Brightness, and
RGB controls contained incorrect information.
• BUG ID 355421 - ARRIRAW: ARRI - ALEXA_LF_Sensor footage displayed an error in the Viewer.
• BUG ID 355544 - ARRIRAW: Loading a legacy .hrox project containing certain .r3d files caused Nuke
to crash.
• BUG ID 355717 - Calling getLinkedKnob() incorrectly on an a unlinked Knob caused Nuke to crash.
• BUG ID 355812 - ARRIRAW: Loading legacy scripts did not load knob settings from the project file.
• BUG ID 356167 - ARRIRAW: Opening a legacy script containing unsupported ARRI footage caused
Nuke to crash.

New Known Issues Specific to this Release
This section covers new known issues and gives workarounds for them, where appropriate.

New Known Issues Specific to Nuke
• BUG ID 355719 - ARRIRAW: Deprecated resolution modes are not labeled in Nuke.
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• BUG ID 355712 - ARRIRAW: The 2668 resolution output mode, necessary for ProRes output, is
currently not available.
• BUG ID 347416 - Rendering a standard Write node that has deep data in its stream causes Nuke to
crash.
• BUG ID 340749 - Mac OS X/macOS only: Reading .r3d files and changing the color version to v1
produces a corrupt image.
This is a known issue in the RED SDK, and will be addressed in a future release.

Other Known Issues
This section covers legacy known issues and gives workarounds for them, where appropriate.

Known Issues Specific to Nuke
AudioRead
• BUG ID 18924 - Changes to the rate control value are not honored when ratesource is toggled
between file and custom.
• BUG ID 18666 - Changing the sample rate has no effect on playback in a Flipbook.
• BUG ID 18465 - The time range control doesn’t limit the range when an endtime is specified.
• BUG ID 18451 - Flipbooking doesn't honor the time range knob.
• BUG ID 18217 - Redo keyframe generation doesn't replace the keys.
• BUG ID 18213 - Changing Draw Style in the Curve Editor or Dope Sheet doesn't redraw the curves
correctly.

BlinkScript/CUDA
• BUG ID 43319 - CUDA: Scripts containing GPU accelerated nodes, such as ZDefocus, display a CUDA
error when the OS wakes up from sleep mode.
As a workaround, close and reopen Nuke to reactivate the CUDA drivers.

CameraTracker
• BUG ID 40798 - Centering a track in the Viewer does not work as expected in proxy or downrez
modes.
• BUG ID 37411 - Sequences containing alpha channels display the alpha premultiplied by the image
in reference thumbnails, rather than just the RGB values.
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Deep
• BUG ID 43383 - Executing a script in command-line mode that reads in a deep image and then
writes it to disk, causes Nuke to crash.
As a workaround, run the script from the Script Editor inside Nuke.
• BUG ID 40145 - Nuke occasionally reads and writes Deep .exr files with a pixel aspect ratio of 1.
As a workaround, preview the .exr in the file browser before reading it into Nuke.

Dope Sheet
• BUG ID 43463 - Scripts containing Ocula's O_VerticalAligner plug-in cause Nuke to crash when you
execute Analyze Sequence with the Dope Sheet open.
• BUG ID 40206 - Adding a curve to the Dope Sheet and then deleting it causes Nuke to crash.
• BUG ID 39426 - Undoing individually animated text characters removes their keys completely from
the Dope Sheet.
• BUG ID 39156 - Keys remapped with descending TimeWarp lookup curves don't snap to frames
when frame snap is enabled.
• BUG ID 38910 - Keys from Viewer buffers not currently being viewed are still visible.
• BUG ID 38630 - Read and TimeClip representations disappear in the Dope Sheet if they are set to
have a non-empty frame expression.
• BUG ID 37869 - The Dope Sheet is not updated correctly when a Retime's speed control is animated.
• BUG ID 37815 - Multiple instances of the same clip within one AppendClip are only represented
once in the Dope Sheet.

EditGeo
• BUG ID 38954 - The transform handle of selections in the Viewer is not updated between frames on
geometry with animation baked into its vertices.
To update the transform handle, toggle the axis alignment control between object and average
normal.
• BUG ID 38699 - Changing the visibility of objects within an Alembic Scene Graph causes geometry to
ignore the EditGeo node.
• BUG ID 38670 - Setting a keyframe can be slow to update the Viewer with the appropriate keyframe
marker.
• BUG ID 36094 - Setting axis alignment to average normal displays the axis incorrectly on edge and
corner vertices.
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Flipbook
• BUG ID 271435 - Flipbook: Using the flipbook with nuBridge installed causes Nuke to crash.
• BUG ID 201156 - Nuke's flipbook defaults to the Write node's colorspace, which can result in
different output when compared to the Viewer.
As a workaround, either flipbook the node upstream of the Write node, or enable Burn in the LUT
in the Flipbook dialog.
• BUG ID 47005 - In the Flipbook Viewer, clicking the Go to start button always goes to frame 0, even
if the clip doesn't start at 0.
• BUG ID 47005 - Enabling Burn in the LUT in the Flipbook dialog uses the rec709 LUT for both
rec709 and rec1886.

Frame Server
• BUG ID 273472 - Canceling or pausing a comp render in the Background Renders panel displays
errors in the terminal.
• BUG ID 272523 - Non-contiguous frame ranges cannot currently be flipbooked.

GPU
• BUG ID 45018 - R3D: Only half float linear gamma space works with GPU debayering.

Import Nuke
• BUG ID 40131 - Importing Nuke in a Python script destroys sys.argv, making command-line
arguments unavailable.
As a workaround, preserve sys.argv in another variable before you import Nuke.
• BUG ID 39836 - Importing Nuke hangs when there are Qt conflicts between Nuke and other
applications.
• BUG ID 38963 - Calling import nuke terminates the Python session if no applicable license is
available.

Linux Only
• BUG ID 271807 - Linux only: Adjusting pane or window borders left and right causes redraw lag.
• BUG ID 199990 - In some situations NVIDIA Quadro Linux drivers 319.23 can cause Nuke to hang
during start up.
As a workaround, update your drivers to 361.42.
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• BUG ID 49262 - Scrubbing in the timeline in large projects can force memory use to hit 100%,
causing Nuke to become unresponsive.
• BUG ID 43766 - Calling uuid.uuid4() causes Nuke to crash due to a bug in libc.
As a workaround, launch Nuke from the command-line using:
LD_PRELOAD=/lib64/libuuid.so.1 ./Nuke8.0
• BUG ID 42581 - Keyboard Shortcuts: Using Ctrl+C to quit Nuke from the command-line when a
dialog box is open displays an error.
• BUG ID 39537 - Using a Blackmagic Decklink Extreme 2 card causes Nuke to become unresponsive.

LiveGroups
• BUG ID 274174 - Reloading a LiveGroup currently resets all edited User knobs.
• BUG ID 272281 - Adding a user knob and then undoing the action sets expression links to nodes
with matching names in main Node Graph.

Mac OS X/macOS Only
• Installation - If you're running Mac OS X 10.10 "Yosemite", you may need to install alternative NVIDIA
CUDA drivers so that Nuke can detect your GPU correctly. You can obtain the required drivers
directly from NVIDIA here:
http://www.nvidia.com/object/macosx-cuda-6.5.18-driver.html.
• BUG ID 316577 - macOS only: Current localization progress does not update if the pointer focus is
on Nuke's menu bar.
• BUG ID 228076 - The PySide QtUiTools library is currently missing from the Nuke build.
• BUG ID 163543 - Mac OS X 10.11 only: Dragging handles in the 3D Comp Viewer can be slow to
respond.
• BUG ID 50371 - Script corruption can occasionally occur on Mac OS X 10.9 (Mavericks), and above,
when writing to SMB 2.1 and SMB 3 Sharepoint locations.
• BUG ID 50182 - Nuke cannot be launched from the Finder if it has already been launched from the
Terminal.
• BUG ID 43343 - Modifying the label of a Python user knob causes Nuke to crash.
• BUG ID 39429 - Crash Reporting: The 'save to' dialog is hidden behind the crash report dialog when
you click Save Report.
• BUG ID 38686 - Enabling Use GPU if available on supported nodes, such as Kronos, in more than
one instance of Nuke at the same time, can cause display corruption and/or entire system freezes.
This seems particularly likely to occur on GPUs with low amounts of RAM, such as the GeForce GT
650M.
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As a workaround, upgrade your NVIDIA drivers, or if this is not possible, only enable GPU
acceleration in one instance of Nuke at a time.
• BUG ID 35123 - PrmanRender: If you're using Mac OS X 10.8 (Mountain Lion) or above, make sure
X11 is installed on your system. Unlike previous versions of OS X, 10.8 and above do not have X11
installed by default.
For more information, see http://support.apple.com/kb/HT5293.
• BUG ID 34697 - Launching Nuke from a network shared drive causes Nuke to crash on launch.
As a workaround, either:
• tarball the installation from Mac OS X and unzip it on the alternate file system (using NFS or
Samba, depending on source), or
• using the command-line, copy the installation from Mac OS X to the network location using the
same file system as the destination.
• BUG ID 33970 - Using a node, such as Grade, as a custom viewer process outputs a blank Viewer.
As a workaround, adjust the Viewer gain control to refresh the Viewer.
• BUG ID 22062 - Nuke doesn't currently give the option to restore the autosave of an unsaved script,
except when Nuke is run from the command-line.
• BUG ID 13638 - The following graphics cards are not currently supported for Mac:
• ATI Radeon X1600
• ATI Radeon X1900
Users with these cards are able to render from the command-line, but in GUI sessions, the Node
Graph renders incorrectly due to a requirement of OpenGL 2 drivers.
• BUG ID 12048 - Nuke crashes if you activate screen sharing when there is no screen plugged in.
• BUG ID 11776 - Node text appears aliased, unclear, or garbled at certain zoom levels.

ModelBuilder
• BUG ID 41352 - Setting the segments control to a negative number causes Nuke to crash.
• BUG ID 41148 - Editing geometry UVs and then switching the Viewer to look at the geometry
through a ScanlineRender node causes Nuke to crash.

Monitor Out
• BUG ID 250107 - Monitor Output: 10-bit output from Blackmagic DeckLink HD Extreme 3D+ cards at
the extents of color ranges is incorrect.
As a workaround, using the Desktop Video Setup utility, ensure that the SDI Settings 4:4:4 RGB
checkbox is enabled and the SDI Configuration is set to Single Link.
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• BUG ID 40942 - AJA Io Express: Enabling monitor output causes Nuke to crash.
• BUG ID 37700 - AJA Kona LHe+ 2k formats are not displayed correctly.

OCIO
• BUG ID 201193 - Read node Metadata tabs occasionally include irrelevant in and out colorspace
controls.

Particles
• BUG ID 41259 - ParticleCache: Setting emit from > points and connecting the emit input to
geometry, does not render all frames to the .nkpc file.
• BUG ID 39796 - ParticleCache nodes upstream of ScanlineRender nodes display ParticleCache is
out-of-date errors for negative frame numbers.
• BUG ID 39210 - ParticleCache: Error messages displayed when read from file is toggled on and off
are not reliably cleared when rendering through ScanlineRender.
• BUG ID 37254 - The progress bar does not cancel if you scrub to a frame that has already been
calculated within the particle system.
• BUG ID 18268 - Enabling color from texture always renders a solid white alpha for the texture.
• BUG ID 17520 - Geometry representation textures are displayed even when display is set to off.
• BUG ID 17243 - Using sprites instead of geometry representations causes particles to render behind
the 3D grid lines.

Pixel Analyzer and Scopes
• BUG ID 44176 - PixelAnalyzer: The full frame sampling mode doesn't work immediately in the
timeline Viewer when the analyzer is initially added to the layout.
• BUG ID 39180 - Scopes: Switching to a layout with a scope window, while rendering, forces the
Viewer bounding box to 1x1 for that frame.
• BUG ID 36508 - Scopes do not currently update when zooming into the Viewer.
• BUG ID 36491 - Scopes clip color values between 0 and 1 when Preferences > Scopes > Include
viewer color transforms is enabled.

PrmanRender
• In the Nuke camera, the window roll control is not yet mapped to RenderMan.
• BUG ID 27648 - After a security update for Mac OS X, Nuke is unable to load the PrmanRender plugin the environment.plist file when in GUI mode.
See http://support.apple.com/kb/TS4267 for more information.
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Python
• BUG ID 44296 - Running nuke.scriptOpen() at the same time as creating a Python panel causes
Nuke to crash.
• BUG ID 40994 - Rendering an Alembic camera using a Python script produces incorrect values when
run from the command-line.
Run the script from Nuke's Script Editor to avoid this issue.
• BUG ID 40645 - Using setInput() within an onCreateCallback doesn't work as expected.
• BUG ID 40534 - Using Python to set metadata in ModifyMetadata nodes does not work from the
command-line.
To work around this issue, run the Python script from Nuke's Script Editor.
• BUG ID 39308 - Accessing a node's x and y positions using the xpos and ypos controls reports
incorrect values.
As a workaround, either call nuke.Node.xpos() or nuke.Node.ypos() first, or ensure no nodes are
currently selected in the Node Graph.
• BUG ID 38994 - nuke.Node.screenWidth() and screenHeight() are incorrect when a node is first
created if it has an autolabel.
• BUG ID 8063 - Creating many new nodes with nuke.createNode() and the in-panel argument at
default (True) may crash when too many node control panels are created too quickly. The
workaround is to pass the in-panel argument as False or else use nuke.nodes.NodeClass() (where
NodeClass is the type of node to create) to create the node and then connect it to the currently
selected node manually.
• BUG ID 6455 - You should not call the Python command nuke.restoreWindowLayout() from the
Script Editor as that can cause Nuke to crash. Instead, you can use the same command from your
menu.py, restore layouts by selecting Layout > Restore Layout, or use a custom menu or toolbar
item.
• Nuke sometimes reports errors in Groups and Gizmos, appearing similar to the following:
groupName.NodeName.knobname: unexpected 'k' in '0.knobname'
The problem is most likely that there is an expression using the input TCL command and doesn't
validate that there is an input connected. An example expression:
[input parent 0].translate.x
The input command returns 0 when it can't find the requested input, which generates an expression
of '0.knobname' that doesn't refer to anything. The fix is to restructure the expression to use the
value TCL command and specify a default value to return in the case that the expression is invalid. It
takes the form:
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[value [input parent inputnumber].knob defaultValue]
Here is the modified example:
[value [input parent 0].translate.x 0]
The modified example returns 0 in the event that there is no input 0, and no longer results in an
error message.
• There is a Python syntax conflict when assigning knob names on the fly with nuke.nodes.<node>()
if the knob is called 'in'.
For example, this gives a syntax error:
nuke.nodes.Shuffle(in = 'depth')
while this works because 'in' is a string here and not a keyword:
sh = nuke.nodes.Shuffle()
sh['in'].setValue('depth')

RayRender
• BUG ID 230256 - Soft Shadows are not currently supported.
• BUG ID 197294 - Reflection occlusion is not currently supported.
• BUG ID 196980 - Clipped alpha shadows are not currently supported.
• BUG ID 196776 - Multiple bounce reflecton is not currently supported.
• BUG ID 196124 - RayRender does not currently support refraction.
• BUG ID 195051 - The Wireframe shader node, located in 3D > Shader > Wireframe, is not
supported by RayRender.
• BUG ID 195004 - Custom lens shaders/projection modes are not currently supported.
• BUG ID 194819 - RayRender does not currently support Deep workflows.
• BUG ID 191108 - Particle sprites are not currently supported.
• BUG ID 174849 - The Displacement shader node, located in 3D > Shader, is not currently supported
by RayRender.

Read and Write
• BUG ID 50046 - The default colorspace values when writing using .mov codecs differ in commandline and GUI modes.
• BUG ID 48935 - MXF: Importing a certain JPEG2000 file causes Nuke to crash or display the file
incorrectly.
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• BUG ID 47256 - MXF: Super whites are currently displayed as white in the Timeline Viewer.
• BUG ID 47248 - MXF: Setting debayer quality to High Quality on some Sony RAW files displays an
error decoding frame message in the Comp Viewer.
• BUG ID 42717 - Certain .exr files rendered from Modo display the alpha channel rather than the
rgba channels by default.
• BUG ID 41006 - The last audio frame of a QuickTime encoded with AAC compression is muted.
• BUG ID 40684 - Rendering certain h264 encoded .mp4 files using the mov32 encoder results in color
shifts using QuickTime 10.3 codecs.
• BUG ID 40533 - There are slight differences in color and sharpness when rendering Alexa footage to
ProRes 4444.
• BUG ID 40074 - Writing out stereo .sxr files with additional channels does not write out both eyes
correctly.
• BUG ID 39165 - ReadGeo: When reading in .fbx files, the transform/scale state can become incorrect
while toggling the read transform from file in combination with all objects and/or read on each
frame.
• BUG ID 35611 - Writing .exrs with the Write node's interleave control set to channels adds a
superfluous main view.
• BUG ID 33863 - FBX geometry: Faces on geometry read in from .fbx files are not connected to
neighboring faces, leaving gaps in certain circumstances.
This issue is particularly visible when using the EditGeo node, which should not allow you to remove
faces from the geometry.
• BUG ID 31424 - Sub-sampling in .exr files is not currently supported.
• BUG ID 27211 - Alembic: The state of the Viewer Lock Frame control is not always honored for .abc
files.
As a workaround, ensure that ReadGeo > read on each frame is enabled.
• BUG ID 21663 - Read: After reading in a stereo/multiview .exr file and choosing not to add new
views to the project, subsequent reads of any stereo/multiview .exr files won’t give the option to add
new views.
• If you have trouble with FBX files, it may be because they were written with an older version of FBX.
If they load very slowly, it is also possible that they are ASCII rather than binary. To get around these
problems, you can use the FBX converter on the Autodesk website. It converts between various
different formats, including older FBX versions, ASCII, and binary, and is available on Windows, Mac
OS X, and Linux.
To download the FBX converter:
1. Go to http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775855.
2. Scroll down to FBX Converter and click on one of the links to start the download.
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Render codecs
Rendering with certain codecs occasionally causes Nuke to crash. Due to this, we recommend the
following:
• If you're using the Sorensen Video codec, it's recommended you use the Sorensen Video 3 codec
instead. If you're unable to switch to Sorensen Video 3, try using a format smaller than 2K for better
performance.
• If you're experiencing crashes with Cineform HD, try updating your Cineform codec to version 5 or
above. You may need to download the Neoplayer at http://estore.cineform.com/neoplayer.aspx.
• If you're using Avid Meridien, you should only write out in NTSC and PAL.

Roto/RotoPaint Open Splines
• BUG ID 42997 - Rendering artifacts can occur if the feather control is used in conjunction with the
feather handles in the Viewer.
• BUG ID 42995 - Stereo: Adding an open spline creates the spline in the left view only by default.
As a workaround, select the shape and then manually change the Properties view control to include
both views.
• BUG ID 42991 - Python API: Moving points on an open spline using Python causes Nuke to crash.
• BUG ID 42932 - Rendering artifacts can appear where the spline hull crosses over itself with negative
feather values.
• BUG ID 42422 - Rotating the tangent of an end point occasionally causes the hull to behave
erratically.
• BUG ID 42413 - Holding Ctrl/Cmd to move a point's tangent handles independently causes defects
in the hull or feather.
• BUG ID 42412 - Changing the Viewer overlay visibility, such as from always to never, occasionally
produces artifacts in the spline's hull.
• BUG ID 42390 - It is not possible to increase the width for individual points if the overall width is
set to 0.
• BUG ID 42387/42310 - Cusped points occasionally cause hull rendering artifacts.
• BUG ID 40962 - Animated splines with varying width and feather occasionally contain slight
rendering glitches inside the hull.
• BUG ID 40433 - Roto Open Splines - Shape of hull/feather curve can look incorrect when width
changes greatly from one point to the next
• BUG ID 36219 - The Select Feather Points tool does not work consistently between the Open
Spline and Bezier tools.
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Other Roto/RotoPaint Bugs
• BUG ID 41917 - RotoPaint shape colors don't change when expression linked to another RotoPaint
color.
• BUG ID 32459 - RotoPaint: Undoing a point move that created a keyframe doesn't currently undo
the keyframe creation.
• BUG ID 32450 - RotoPaint Stereo: Attempting to undo multiple split-control transforms on the same
shape reverts the shape to its original position.
• BUG ID 31552 - Point handles for paint strokes, whose lifetime doesn’t extend to the current frame,
disappear when drag-selected.
As a workaround, select the shape in the curves list to re-display the points.
• BUG ID 30920 - Expression linking extra matrices in the Transform tab doesn’t work as expected.
NOTE: This also applies to SplineWarp matrices.
• BUG ID 30551 - Several levels of smoothing applied to one shape are carried over to subsequent
shapes for a single smooth operation.
• BUG ID 29170 - The cut, copy, and paste keyboard shortcuts don't work for entries in the curves list.
• BUG ID 28838 - Gizmos from Nuke 6 containing Roto/RotoPaint nodes should be recreated in Nuke
8, but bear in mind that they won’t be backwards compatible with Nuke 6 once converted, unless
you follow the instructions below:
Nuke 6 scripts containing Roto display a conversion prompt when you open them in Nuke 8:
• Click Save As to convert the script to the Nuke 8 Roto format, or
• Click Ignore to load the Nuke 6 format into Nuke 8. You might select this option if:
- You don't intend to make any changes, or
- You want to overwrite the file with a Nuke 7 and 8 only Roto format when saving.
If you want Nuke 8 scripts to load in Nuke 6, use the convertToNuke6 or
convertDirectoryToNuke6 Python functions when running Nuke 8 in command-line only mode:
NOTE: The conversion functions cannot convert stereo-split curves as they are not
supported by Nuke 6.
• To convert individual .nk scripts:
convertToNuke6(fromScript, toScript, overwrite = False)
• To convert all .nk scripts in a given directory:
convertDirectoryToNuke6(fromDir, toDir, matchPattern =.*\.nk, overwrite =
False)
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NOTE: The pattern is a regular expression.
An example single script conversion and rename to the same directory, from the command-line (or
Terminal):
$ <NukeInstallDir>/Nuke8.0v1 -t
>>> import nuke.rotopaint
>>> nuke.rotopaint.convertToNuke6(/tmp/myRoto8.nk, /tmp/myRoto6.nk)
• BUG ID 26855 - The undo and redo buttons in the Properties panel didn’t work as expected and
have been disabled.
The workaround is to use the undo (Ctrl/Cmd+Z) and redo (Ctrl/Cmd+Y) keyboard shortcuts or the
Edit menu instead.
• BUG ID 21361 - Artifacts are produced until mouse up when painting over a stroke on another
frame.
• BUG ID 11524 - Adding strokes/shapes in RotoPaint is slow when there is another RotoPaint after it.
• BUG ID 9238 - Painting on Mac OS X and Linux is slower when the paint cursor is near the edges of
the screen.
• The foreground onion skin overlay updates as you paint, rather than only updating with the new
stroke on pen up.
• It is not currently possible to clone RotoPaint nodes.
• Interactivity of laying down strokes/shapes in the Viewer may be faster when motion blur is disabled
on the layer you are working in.

ScanlineRender
• BUG ID 38329 - Deep renders from ScanlineRender currently ignore the ScanlineRender's bg input.
• BUG ID 38205 - Deep: Depth, motion, position, and normals information is occasionally incorrect in
semi transparent areas.
• BUG ID 37967 - Deep: Geometry with alpha 0 renders black when the deep output is converted to an
image.

SmartVector Toolset
• BUG ID 275683 - SmartVector: Due to VFX Platform library changes, vectors generated by the Nuke
11 SmartVector toolset do not match legacy versions. For example, vectors generated by Nuke
11.0v1 do not match those generated by Nuke 10.5v4.
• BUG ID 196455 - Rendering vectors after correcting the file control in the SmartVector node
occasionally displays a spurious No such file or directory error.
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As a workaround, scrub to a different frame to remove the message.
• BUG ID 175605 - Entering a partial file path in the SmartVector file control and then clicking the file
browser icon does not open the file browser.
As a workaround, click OK on the error message and then click the file browser icon again.

Text
• BUG ID 48418 - Different operating systems handle the Shadows tab shrink/expand control
differently, producing inconsistent output.
• BUG ID 39556 - In text edit mode, it is not currently possible to edit text attributes when the Viewer
overlay is disabled.
• BUG ID 39552 - Transforming animation groups using an expression-linked Transform node does
not work as expected.
As a workaround, expression link the translate x and y controls separately.
• BUG ID 39291 - Splitting the transform control on the Group tab splits all controls.
• BUG ID 39239 - Transforming a character generated from an expression, and then going to a frame
where the character no longer exists, results in the transformation being lost.
• BUG ID 39130 - Splitting the message field does not work as expected.
• BUG ID 38789 - Viewer toolbar controls steal cursor focus.
• BUG ID 38425 - The undo history becomes unreliable when the panel focus changes.
• BUG ID 36372 - Selecting a TCL expression in the message field doesn't always select the result in
the Viewer.

Tracker
• BUG ID 40542 - After tracking and centering a track, the Viewer no longer caches when playing back
the tracked frames.
As a workaround, you can enable full frame processing, though this may increase render times.
• BUG ID 40038 - Ctrl/Cmd clicking in the Viewer to select a pixel and then adding a track, sets the
tracking anchor coordinates to 0,0.
• BUG ID 39225 - Moving tracking anchors is occasionally unresponsive and jerky.
• BUG ID 39200 - Holding Shift and clicking tracks in the Viewer doesn't add to the current selection.
• BUG ID 38356 - The zoom window occasionally doesn't update correctly when scrubbing between
frames.
• BUG ID 32359/32353 - Right-clicking on a point in the Viewer doesn’t always update the available
Link to > Tracker linkingdialog or Tracker options.

RELEASE NOTES
77

Release Notes for Nuke and Hiero 11.2v1 | Other Known Issues

As a workaround, close and re-open the Roto/RotoPaint properties panel to update the Link to
menu.
• BUG ID 29382 - Tracking keyframes with different sized patterns doesn’t work as expected.
As a workaround, keyframe patterns should, where possible, be of comparable sizes.

VFX Platform
• You may experience issues when importing PySide modules into their Python scripts due to the
migration from PySide 1.2.2 to PySide 2.0.
In some cases, you can just change calls to:
import Pyside.some_module
to:
try:
import Pyside.some_module
except:
import Pyside2.some_module
However, the definition of some classes has moved between modules in PySide 2.0. This particularly
affects any Widget related classes, which have been moved from QtGui to QtWidgets, however there
are other cases where this may be experienced.
If you experience any problems with this, please refer to the Qt 5.6.1 documentation, or contact
support.foundry.com.
• BUG ID 282593 - Switching to a fullscreen workspace on the primary monitor occasionally causes
the secondary monitor to turn black.
• BUG ID 280371 - Mac OS X/macOS only: OpenGL errors are printed on the command line when
using an ATI Radeon 5770 GPU.
• BUG ID 277875 - VFX Platform: Switching workspace occasionally draws the new workspace
incorrectly.
• BUG ID 277548 - A QComboBox with a custom QCompleter currently emits incorrect signals.
• BUG ID 275719 - Mac OS X/macOS only: The Help > About Nuke pop-up is positioned incorrectly on
some machines.
• BUG ID 275251 - Mac OS X/macOS only: Hovering over clip instances in the timeline does not change
the pointer icon.
• BUG ID 275246/270914 - The terminal or command line displays libpng warning: iCCP: cHRM
chunk does not match sRGB on start-up.
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• BUG ID 274301 - Node toolbar menu items do not always deselect correctly.
• BUG ID 274264 - CameraTracker results from Nuke 11.1 are not identical to previous versions of
Nuke, though the differences are negligible.
• BUG ID 272767 - Launching Nuke from the terminal with the -b argument has been deprecated as a
result of library upgrades to comply with the VFX Platform 2017 requirements. There are two
workarounds available on Mac and Linux :
• Run Nuke from the Terminal with & added to the launch command. This allows Nuke to run in
the background and returns the command prompt, but closing the Terminal still causes Nuke to
close. For example:
./Nuke11.1v1 --studio &
• Run Nuke from the Terminal using the nohup command. This allows Nuke to run in the
background and returns the command prompt, but closing the Terminal does not cause Nuke
to close. For example:
nohup ./Nuke11.1v1 --studio &
TIP: The nohup command prints output to /Users/<username>/nohup.out or
/home/<username>/nohup.out by default, but you can specify a different file by appending
> /filepath/filename to the command. For example:
nohup ./Nuke11.1v1 --studio & > /Users/<username>/nuke.out
• BUG ID 272750 - The remove all panels button in the node Properties panel is displayed
inconsistently.
• BUG ID 272504 - The timeline Viewer in and out point previews are not working as expected when
scrubbing.
• BUG ID 272442/281108 - The Licensing dialog jitters when moved around the screen.
• BUG ID 272338 - The Windows command prompt displays QWidget::paintEngine: Should no
longer be called on launch.
• BUG ID 272274 - Closing Nuke Studio does not remove the application icon from the task bar.
• BUG ID 271632 - Nuke prints a libDeckLinkAPI.so error in the terminal on launch.

Warpers
• BUG ID 32340 - SplineWarp: Using Ctrl/Cmd+drag to create rectangles and ellipses doesn't display
an overlay until pen-up.
• BUG ID 32083 - SplineWarp: Deleting all but one point on a curve resets its correspondence points
to 0,0, which cannot be undone.
• BUG ID 32082 - SplineWarp: Correspondence points are too sensitive when control points are
removed.
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• BUG ID 32079 - SplineWarp: Moving correspondence points on curves with no keyframes cannot
currently be undone.
• BUG ID 30429 - SplineWarp: Transform links are not maintained when the source curve is moved to
a new layer.
• BUG ID 31322 - SplineWarp/GridWarp: Preview doesn't handle upstream transforms correctly.
• BUG ID 20000 - GridWarp: When using cropped input, moving control points causes the Viewer to
display the cropped image and the black area between the crop box and the format when merged
over a background.
• BUG ID 19995 - GridWarp: Locked source and destination grids still allow adding and removing grid
lines.
• BUG ID 19835 - SplineWarp/GridWarp: The Viewer LUT is incorrect in morph mode, when mix is set
at an intermediate value.
• BUG ID 19755 - SplineWarp: Placing correspondence points at each end of an open spline causes
rendering problems.
• BUG ID 19565 - GridWarp: The Viewer does not show the correct mix amount when in morph mode
with mix set at an intermediate value.
• BUG ID 19386 - GridWarp: All keyframes are removed from the Dope Sheet after undoing, rather
than just the latest, and the keyframes remain on the timeline and in the properties.
• BUG ID 19148 - SplineWarp: Rendering fails if a curve is reduced to a single point.
• BUG ID 19079 - SplineWarp: The C keyboard shortcut does not currently select the Add
Correspondence Point tool.
• BUG ID 18712 - GridWarp: The timeline currently shows both source and destination keyframes,
even if a grid is not visible in the Viewer.
• BUG ID 18709 - GridWarp: Rotating the transform jack with both grids selected, but in different
positions, does not undo as expected.
• BUG ID 18342 - SplineWarp: The spline keyframe + button does not add keys to the Curve Editor or
Dope Sheet.
• BUG ID 18304 - GridWarp: Existing control point keyframes are not cleared when you draw a new
grid using the Draw Boundary Viewer button.
• BUG ID 18019 - GridWarp: You cannot select all grid points in the Curve Editor using Ctrl/Cmd+A
shortcut.
• BUG ID 18012 - GridWarp: The grid can flicker between white and gray when zooming in and out of
the Viewer, particularly when the grid is subdivided.
• BUG ID 17697 - GridWarp: In stereo mode, the right view is labeled as default when you split
controls into separate views.
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Windows Only
• Nuke Non-commercial: Navigating to Help > License, clicking Deactivate or Deauthorize, and then
clicking Quit, causes Nuke Non-commercial to crash on exit.
As a workaround, change the mode a few times until it work as expected.
• BUG ID 198430 - Nuke cannot read DNxHD .mxf files that have spaces in the file name.
• BUG ID 46759 - File Browser: Location defaults (such as Home, Root, etc.) may not display if you
have a previously saved FileChooser_Favorites.pref file in your ~/.nuke directory.
As a workaround, move or rename the FileChooser_Favorites.pref file, and re-launch Nuke.
• BUG ID 40407 - When using a tablet, Nuke does not automatically switch to Eraser mode when you
use the erase end of the pen.
• BUG ID 39636 - QuickTime: The Blackmagic 10 bit (v210) codec defaults to the YCbCr 8-bit 422
(2vuy) pixel format due to a bug in the codec, resulting in solid green frames.
As a workaround, manually set the pixel format to b64a RGB to preserve image fidelity.
• BUG ID 35800 - Scopes: The alpha channel doesn't update correctly when modified through a node,
such as Primatte or Shuffle, even after the node is removed from the Node Graph.
• BUG ID 28921 - Changing the 3D selection mode does not update until you click in the Viewer.

Miscellaneous
• BUG ID 339241 - MatchGrade: Clicking Analyze Reference Frames with a Read node with no valid
file path displays an Uncaught C++ exception occurred during the execution of python script!
error.
• BUG ID 312350 - Visual Diagnostics: The Profile tab occasionally flickers when the application
window is maximized.
• BUG ID 309259 - Documentation: The Python Developers Guide incorrectly references Qt 4.8.5
source code.
For links to the correct source files, see the Nuke Developers page under Nuke Qt binaries and
source files: https://www.foundry.com/products/nuke/developers
• BUG ID 273462 - Licensing: Nuke cannot retrieve a license from the license server when the
hostname contains .local.
• BUG ID 272296 - Adding a user knob and then undoing the action doesn't remove the added knob.
• BUG ID 271804 - Documentation: The node Properties panel ? link to the reference documentation
doesn't work as expected.
• BUG ID 271456 - UI: Some interface elements appear larger than usual when compared to previous
versions of Nuke.
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• BUG ID 271256 - Denoise: Rendering frames to disk with a Temporal Frame Offset greater than 1
causes Nuke to crash.
• BUG ID 271074 - PointCloudGenerator: Track Points does not work as expected when creating a
point cloud from CameraTracker data.
• BUG ID 228258 - Calling fromScript() on a knob that has not been added causes Nuke to crash.
• BUG ID 226394 - Preferences: There are currently duplicate Script Editor controls under Other in
the Preferences dialog.
• BUG ID 169458 - Compositing Viewer: Setting the gamma control to 0 with Panels > Viewer (Comp)
> use GPU for Viewer when possible enabled in the preferences, renders the alpha channel black.
• BUG ID 168350 - AMD GPUs are reported as ATI GPUs in the node properties and --gpulist on the
command line.
• BUG ID 50715 - ZDefocus: Switching the filter type to image causes Nuke to crash in a customer
script.
• BUG ID 49803 - AJA Monitor Output: Setting the NUKE_AJA_CHANNEL environment variable to 4
when the NUKE_AJA_DUALOUTPUT environment variable is set, streams the output to SDI3, rather
than SDI4.
• BUG ID 49186 - ColorCorrect: Adding an expression to the curves on the Ranges tab and then
changing a value, such as Gain, causes Nuke to crash.
• BUG ID 46488 - Switching between certain workspaces displays black in the Viewer until the frame is
changed.
• BUG ID 46441 - ParticleBounce: Using custom geometry as the bounce object in a particle system
occasionally allows particles to pass through the bounce surface.
• BUG ID 42339 - The Modo Viewer control scheme (Preferences > Panels > Viewer Handles > 3D
control type) does not work as expected.
• BUG ID 42240 - Setting a channel with a non-standard name to use as the Viewer's alpha channel
doesn't work as expected.
• BUG ID 42159 - Nodes that use the Iop::sample() call to get input pixels, such as LensDistortion,
perform poorly when they are downstream of nodes using PlanarIop, such as Denoise.
• BUG ID 41450 - AppendClip forces upstream nodes to re-evaluate on every frame.
• BUG ID 41411 - Loading a script from a disconnected network drive creates an empty script with the
same name as the file path to the original.
WARNING: If you save this empty script when the network drive is reconnected, the original
is overwritten.
• BUG ID 41122 - MatchGrade: Match Different Clip mode does not allow you to set keyframes on
the Target for .mov clips with a frame range offset.
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• BUG ID 40617 - Some filter nodes, such as Erode (fast), are caching more slowly than in previous
versions.
• BUG ID 39459 - Virtual Sliders: Clicking the left-mouse button, while holding down the middlemouse button, pastes values into the control.
• BUG ID 39407 - Project3D: The node class name has changed to Project3D2. As a result, the
Nuke<>Mari bridge won't work unless all instances of Project3D are renamed appropriately in the
mari_bridge.py file.
• BUG ID 39365 - The Viewer headlamp control can not currently be managed using expression links.
• BUG ID 39287 - Plug-ins: Loading scripts with plug-ins compiled against older versions removes the
nodes from the Node Graph.
• BUG ID 39260 - Custom knobs on Groups and NoOp nodes cannot be retimed.
• BUG ID 39122 - Switching the Viewer to wipe mode and wiping between inputs with different format
sizes causes corruption and constant refreshing in the Viewer.
• BUG ID 38713 - Capture: Roto opacity and feather settings are not included in captured images.
• BUG ID 35661 - Capture: Capturing the Viewer with a custom file path saves the file path in the
script, resulting in error when the path doesn't exist:
Flipbook render failed: viewerCaptureOp: Cannot write to specified path
• BUG ID 35659 - Capture: Capturing a 3D scene containing lights produces Viewer flashes in the
captured images.
• BUG ID 32856 - PositionToPoints: Textures occasionally disappear during playback or when
mousing over the Viewer.
• BUG ID 32666 - FrameHold nodes have no effect on Deep nodes.
• BUG ID 32628 - DeepToPoints: Command-line rendering appears to calculate renders even when
render is set to off.
• BUG ID 32497 - The R3D parameter labels in Nuke aren’t entirely consistent with REDCINE-X and
Hiero.
• BUG ID 32219 - DepthToPosition: Reading depth information from the same layer as the output
layer produces corrupt output.
As a workaround, shuffle the depth information to an alternate layer.
• BUG ID 32118 - Card3D: When motionblur is enabled in the properties, FrameHold and TimeOffset
nodes are ignored when connected to the cam or axis inputs.
• BUG ID 31803 - Using Shift+drag on a control’s animation icon only copies the value for the current
frame, not the entire expression.
• BUG ID 31714 - In the Viewer settings, enabling 3D > show_prim_bbox does not display individual
bounding boxes for polymesh primitives.
• BUG ID 31310 - TimeOffset: Checking reverse input doesn’t affect cameras, lights, or axes.
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• BUG ID 31238 - RAM cache: Any action that changes a frame’s hash value, it’s unique identifier,
causes the cache to release. Actions such as adjusting the Viewer Gamma, Gain, or channels
dropdown affect the frame hash.
• BUG ID 30502 - Copying and pasting spline keys does not work as expected in the Dope Sheet.
NOTE: This known issue only applies to Roto and SplineWarp keys.
• BUG ID 30256 - Script Editor: Flagging a control as invisible using setFlag() is not honored when the
node is copy/pasted in the Node Graph.
• BUG ID 30173 - Manipulating 3D handles in the 2D Viewer is unreliable.
• BUG ID 29677 - Connecting a FrameHold node to an animated Camera and connecting both to a
Scene node only displays the animated Camera in the Viewer. There should be two cameras: one
static and one animated.
• BUG ID 29083 - Using Create Camera in the 3D Viewer only sets position and rotation. The focal
length of the new camera does not match that of the Viewer camera.
• BUG ID 28291 - Nuke crashes on start up if the disk cache location set in the Preferences is no
longer available.
• BUG ID 20431 - CameraTracker: It’s not possible to pick colors in the Viewer with the control panel
open.
• BUG ID 20204 - Multitexturing: When Preferences > Viewers > Multiframe is enabled, increasing
downrez in the Viewer toolbar can cause textures to flicker in the 3D Viewer.
You can switch back to Classic mode or avoid using proxy in 3D to workaround this issue.
• BUG ID 19933 - ReadGeo: Geometry occasionally doesn't display as a solid until you click in the
Viewer.
• BUG ID 19185 - Attaching an FBX ReadGeo to the Viewer occasionally causes a slight graphical glitch
in the Properties panel.
• BUG ID 18649 - The transform jack is currently scaling incorrectly from the corner pivot point.
• BUG ID 12505 - Motion Vector output has been improved, but still doesn't work properly because
some large polygons are clipped by the front camera plane.
You can minimize this effect by increasing the geometry tessellation max parameter.
• BUG ID 12424 - Ultimatte: Overlays are not updating correctly or reverting when panning or
zooming.
• BUG ID 11620 - In the 3D Viewer, there is currently a conflict between 3D geometry selection and
points drawn with RotoPaint. This only occurs if you have two Viewers open, one in 2D mode and
the other in 3D mode, and you have the panel for the RotoPaint visible.
• BUG ID 9521 - Currently, the Nuke Viewer cannot cache very large plate sequences in float. The limit
per frame is 50MB. If your frames are larger than this, you may need to switch to proxy mode for
the caching to work.
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• BUG ID 5922 - At the moment, cloning does not work properly with all OFX nodes. This affects, but is
not restricted to, any nodes that have an analysis pass.
• BUG ID 5690 - Windows run-time libraries are not packaged properly with Nuke.
Nuke runs correctly from a network install on Windows without specifically installing the run-time
libraries, though we still recommend that you do so as there are still some minor problems without
them.
• BUG ID 5083 - Flipbooking the output of the Anaglyph node asks which view you want to render.
This question is unnecessary as the result is an anaglyph image. Irrespective of what view you
choose, the flipbook output is the same.
• File types in Windows and Mac OS X are associated with the standard version of Nuke by default, so
if you save a script on NukeX using features that are only included in NukeX (such as CameraTracker
or FurnaceCore) and then double-click on the script icon to open it, it opens in standard Nuke
instead of NukeX.
• CameraTracker: Canceling lens distortion initialization results in corrupt tracks.
• 3D Camera: If you want to navigate through the 3D point cloud created by the CameraTracker node
when using Create Scene:
• Select the Camera that was created in the 3D view when using the Create Scene button.
• Press F to focus on the selected Camera. You can now navigate around the cloud. Do not try to
focus (using F) on the point cloud. The resulting tumble camera movement is likely to be jumpy.
• Plug-ins installed using the Nuke Plug-in Installer may not work correctly as they were compiled
against an earlier version of Nuke.

Known Issues Specific to Nuke Studio and Hiero
AAF
• BUG ID 274824 - Elastic keyframes imported from Avid do not translate correctly into Nuke Studio.

Create Comp
• Multi-view, such as stereoscopic, is not supported for clip instances created using right-click Effects
> Create Comp.
• BUG ID 47044 - Inserting scripts into comps containing Text nodes using unsupported fonts causes
Nuke Studio to crash when the Text nodes are disabled.
• BUG ID 46470 - Create Comp: Enabling Collate Shot Name in the comp export preset offsets the
comp frame range compared to the annotations precomp frame range.
• BUG ID 41665 - There are currently no options to load or overwrite an existing script when you
select Create Comp.
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Exporting
• BUG ID 49024 - Enabling the Collate... options in the Export dialog when exporting ignores the
Media tab Output Resolution setting for the track above, and produces output with incorrect
formatting.
• BUG ID 47828 - Exporting retimed or reversed clips as .xml does not work as expected when
imported into Final Cut Pro.
• BUG ID 46403 - Controls set in the Export dialog Content tab occasionally default to the values
from the Nuke Write Node Content preset.

Linux Only
• BUG ID 282599 - Linux only: Input and timecode metadata is currently incorrect in the timeline
Viewer if the framerate is changed.
• BUG ID 239672 - Reading files from NTFS disks/partitions can be extremely slow, particularly for
large files. This is a limitation of Linux NTFS file systems, rather than Foundry products.
We recommend avoiding timeline playback that relies on source footage from NTFS
disks/partitions.
• BUG ID 235327 - CPU usage can reach 100% on a single thread during flipbooking, causing Nuke to
become unresponsive.
• BUG ID 167058 - PulseAudio (ALSA) can cause Nuke Studio to crash or impair playback.
As a workaround, you can stop the pulseaudio daemon:
1. Open /etc/pulse/client.conf
2. Set autospawn = no and daemon-binary to /bin/true. Ensure these lines are not
commented out.
3. Call ps -e | grep pulse to check the process is still running.
4. Call pulseaudio --kill
5. Call ps -e | grep pulse again to check the process has stopped.
• Linux only: Nuke Studio does not currently support any QuickTime audio reading. Support for audio
on Linux is scheduled for a later release.
• BUG ID 32613 - Dragging clips to the timeline with certain older NVIDIA drivers occasionally causes
Nuke Studio to crash.
As a workaround, ensure that you have the latest NVIDIA drivers installed, available from:
www.nvidia.com/Download/index.aspx?lang=en-us
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Mac OS X/macOS Only
• BUG ID 39113 - QuickTime ProApps Codecs v1.0.3 break HDV and XDCAM on Mac OS X 10.7.5, and
earlier.
This is a codec issue rather than an application issue.
• BUG ID 34779 - The shortcut for Clear In/Out Points (Alt+U) is not always triggered correctly due to
a conflict with the combination for the umlaut symbol.
To work around this, press U momentarily before Alt+U.

OCIO
• BUG ID 198348 - Saving and closing a project that uses an OCIO config, and then relocating the Nuke
install path, causes a Could not load OpenColorIO config error on reload.

Preferences
• The Preferences > Path substitution table for cross platform compatibility currently only comes
into effect at project load, not EDL/XML import.
As a workaround, import your sequence and set the Path substitution rule, then save the project
and reload to force the conversion.

Python API
• BUG ID 50113 - QActions are not added to the Edit menu in the menu bar when finding the menu
action by name.
As a workaround, use the objectName (foundry.menu.edit), where possible.
• BUG ID 44394 - Calling hiero.core.addPathRemap() does not work for soft effect file paths.

Read and Write
• BUG ID 278312 - Read/Write: The import progress bar occasionally persists after the import is
complete, and cannot be closed.
As a workaround, save and close the project, then restart Nuke Studio and reload the project.
• BUG ID 49912 - HieroPlayer: Projects created in version 1.9, or earlier, are not editable in
HieroPlayer 9.0.
• BUG ID 46174 - XML: Shot names are occasionally not imported correctly from Adobe Premiere .xml
files.
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• BUG ID 46100 - Exporting: Export speeds may be slower than expected. This may be due to the
Rendering preference set to limit renderer.
As a workaround, you can change the preference Performance > Threads/Processes > Rendering
> export renders to no renderer limits to improve rendering speeds. You can also experiment
with the custom renderer limits to adjust performance on your machine.
• BUG ID 39897 - Importing and playing back very large format .tif files causes Nuke Studio to crash.
• BUG ID 39557 - Writing .exrs with 200+ layers, when interleave is set to channels, can be sluggish.
• BUG ID 36726 - Executing Clip > Rescan Clip Range displays frame read errors if the rescan adds
frames to the clip.
• BUG ID 35080 - QuickTime: Certain files read into Nuke Studio with a different start timecode to
other applications, such as Premiere or Resolve.
• BUG ID 31549 - Single layer exports from multi-pass clips fail if the selected layer is not a default
Nuke layer, such as depth or motion.
• BUG ID 28067 - Certain formats produce no monitor output, such as 2K 23.98 and 720P 25.
• BUG ID 18880 - R3D: The aspect ratio of anamorphic .r3d footage is not displayed correctly when
added to the timeline.

Soft Effects
• BUG ID 280413 - Soft Effects: The Text effect cursor placement shifts incorrectly after typing first
character.
• BUG ID 278275 - Soft Effects: Closing a Timewarp effect's Properties panel disrupts the interface
briefly.
• BUG ID 275314 - Soft Effects: Additional keyframes are added incorrectly when animating Text
effects.
• BUG ID 230536 - The Burn-in effect does not maintain a constant text baseline for all characters
when the format is changed.
• BUG ID 175574 - Undo and redo of Properties panel changes can be unreliable if a soft effect delete
is in the same undo stack.
• BUG ID 50442 - TimeWarp: Applying a TimeWarp to a clip instance occasionally causes the
associated sequence bin item to display an error.
• BUG ID 50441 - TimeWarp: Applying a TimeWarp to clip instances retimed to values other than 100%
does not work as expected.
• BUG ID 49771 - Text/Burn-in: Nuke Studio doesn’t warn you if the font used in an effect could not be
found.
• BUG ID 49298 - Burn-in: The Burn-in effect does not auto-update when switching between
sequences until the playhead is moved.
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• BUG ID 49112 - Dissolve transitions do not work as expected in Custom soft effects, based on the
examples provided here:
<install_directory>/pythonextensions/site-packages/hiero/examples/custom_
soft_effect.py
• BUG ID 48970 - Burn-in: Burn-in elements are not updated automatically when the underlying
metadata is updated.
As a workaround, either change the frame displayed in the Viewer or choose an alternate element
from the dropdown controls.
• BUG ID 48878 - Burn-in: The Burn-in effect is currently a gizmo and cannot be cloned on the
timeline.
• BUG ID 48098 - Adding a transition when a Text effect containing an expression is on a track above,
causes text rendering to fail during the transition.
• BUG ID 48097 - Adding a transition when a Text effect containing an expression is on a track above,
causes the text size to reset.
• BUG ID 47075 - Exporting sequences containing clip-level Text effects using the [frame] expression
writes incorrect frame numbers.
• BUG ID 45835 - Expression links are incorrectly allowed between node and soft effect controls in the
Properties panel, if the node and effect names are identical.
• BUG ID 42438 - Effects are only visible in the Viewer if there is a clip instance below them in the
timeline.
• BUG ID 42401 - Renaming a soft effect does not update the clip instance until you click in the
timeline.
• BUG ID 42307 - Adding soft effects at clip level, using Open In > Timeline View, is only available
using the toolbar button on the timeline panel. The right-click Effects menu is currently disabled.

Timeline
• BUG ID 43913 - Locking a track currently prevents adding clip instances from the locked track to the
Viewer input buffers. You can still open clip instances in the various right-click Open In options and
access clip instance metadata.
• BUG ID 41745 - It is not currently possible to drag-and-drop a clip to a new track between or below
existing tracks.
As a workaround, drag the clip to a new top-level track and then manually move the track to the
required position.
• BUG ID 27484 - It is not currently possible to alter the Output Resolution of clips opened using the
right-click Open in Timeline option.
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Timeline Disk Caching
• BUG ID 280256 - Opening a Text effect's Properties panel directly after project load causes the
cache bar to disappear.
• BUG ID 272897 - Caching continues after closing the project associated with the frames being
cached.
• BUG ID 270934 - The caching logic does not currently account for gaps in sequences, resulting in the
caching state icon remaining gray for fully cached sequences.

Timeline Read Nodes
• BUG ID 313013 - Opening the Node Graph from the Project bin and then returning to the timeline
environment behaves as if the left mouse button is held down.
As a workaround, left-click in the timeline to cancel the mouse press.
• BUG ID 310067 - Loading large projects is currently slower than expected.

Windows Only
• BUG ID 314088 - Localization: The first frame of localized files in the outdated state, colored red, do
not always update correctly.
• BUG ID 49339 - Soft Effects: The background on Burn-in effects, when enabled, alters size
depending on the timecode displayed.
• BUG ID 28701 - Nuke Studio cannot currently parse Unicode characters during export.

Miscellaneous
• BUG ID 313849 - Localization: Reading certain multiview .exr files causes Nuke to crash.
As a workaround, rename or move your .nuke folder and re-launch Nuke to refresh the uistate.ini
file.
• BUG ID 272723 - Closing Nuke Studio when it was launched from the command line does not end all
Nuke processes.
• BUG ID 200015 - Selecting multiple bin clips can cause the right-click menu to respond slowly.
• BUG ID 167919 - Localization: Re-importing clips into the Node Graph or project bin multiple times
retains the original localization policies settings.
• BUG ID 50490 - Audio: Zooming in on a waveform displays a Failed to decode audio error in the
timeline.
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• BUG ID 50102 - Adding a custom Hiero window to a workspace and then saving it as the Nuke
default workspace causes Nuke to crash on start up.
• BUG ID 46235 - Comps with relative paths are not currently working when imported into the project.
• BUG ID 42462 - Cache pausing stops working if any change is made to the timeline.
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Developer Notes
Here are the changes relevant to developers. See Help > Documentation from the Nuke menu bar or
www.thefoundry.co.uk/products/nuke/developers/111/ndkdevguide/appendixc/index.html for more
information.
As Nuke develops, we sometimes have to make changes to the API and ABI under the hood. We try to
keep these changes to a minimum and only for certain releases, but from time to time API and ABI
compatibility is not guaranteed. See the following table for the situations when you may have to
recompile your plugins and/or make changes to the source code.
Release Type

Example

Compatibility

Version

10.0v1 to 10.0v2

API and ABI

Point

10.0v1 to 10.5v1

API

Major

10.0v1 to 11.0v1

-

Recompile

Rewrite

Additionally, node Class() names occasionally change between major releases. While these changes
do not affect legacy scripts, you may not get the results you were expecting if a node class has been
modified. The toolbars.py file, used to create Nuke's node toolbar, contains all the current node class
names and is located in <install_directory>/plugins/nukescripts/ for reference.
As an example, between Nuke 9 and Nuke 10, the CameraShake node Class() changed from
CameraShake2 to CameraShake3. In the toolbars.py file for the two releases, the entries for the
CameraShake node appear as follows:
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake2\")",
icon="CameraShake.png")
m.addCommand("CameraShake", "nuke.createNode(\"CameraShake3\")",
icon="CameraShake.png")

New Features
There are no new features in this release.
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Feature Enhancements
• BUG ID 197003 - Localization: You can now query a Read node's localization state using Python API
calls. See File Localization API Extension for more information.

Bug Fixes
• BUG ID 348068 - Python: The onDestroy() callback was called twice on exit.
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